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Welcome
What is the F20 used for?
The Filmetrics F20 is used to measure the thickness and optical constants (n and k) of dielectric and
semiconductor thin films. Measured films must be optically smooth and within the thickness range set
by the system configuration requirements specified in Performance Specifications. Commonly
measured films include semiconductor process films such as oxides, nitrides, resists, and polysilicon,
optical coatings such as hardness and anti-reflection coatings, flat panel display films such as polyimides,
resist, and cell gaps, and the various coatings used in CD and DVDmanufacture.

Warning: Accurate measurements require suitable recipe settings and a valid baseline. Improper system setup or
an aged lamp may also lead to errors. It is the user’s responsibility to ensure that this instrument is being used
properly for its intended purpose. Please contact Filmetrics support for assistance with any questions.



Safety, Maintenance, and Care

This symbol indicates information or instructions that must be read and carefully followed to prevent
hazards, injury to the operator, or damage to the instrument.

This symbol indicates a potential shock hazard. Areas marked with this symbol should be serviced by a
trained service technician.

This symbol indicates that the product conforms to theWEEE (Waste in Electrical and Electronic
Equipment) Directive 2002/96/EC.

This symbol indicates that the product meets the applicable EU safety, health and environmental
protection directive requirements.

This label indicates theModel Number and Serial Number of the instrument. This information may be
necessary when contacting Filmetrics for assistance.



Disclaimer: Use of this instrument in a manner inconsistent with the information and directions included
in this manual may impair the protections designed into the product resulting in danger to the operator
or damage to the instrument

Installation Location:When deciding on a location for the instrument, ensure that the instrument in
installed in a well-ventilated location. Enclosing the unit, or blocking the vent holes, may impair the
performance of the instrument of damage the internal components.

Cleaning: The need for periodic cleaning of the system is based on the cleanliness of the environment in
which the system is installed. Only the external surfaces are to be cleaned. Cleaning and maintenance of
all internal components is to be performed by a trained service technician. Do not use aerosol, or spray,
cleaners as they may contaminate the sensitive optical surfaces on the instrument.

Before performing any service on the instrument ensure that themain power is disconnected.

Cleanroom, or low lint, wipes should be used to wipe down the system. Amixture of Isopropyl Alcohol
(IPA) and De-ionized Water (DI H2O) at 70%DI H2O: 30% IPA is to be used for cleaning. Undiluted IPAmay
be used, if the 70:30 DI and IPAmixture is not available, but extra caremust be taken. Avoid using
stronger solvents, such as acetone, as thesemay compromise the surface finish.

Avoid excessive pressure on any surface when cleaning. Excessive forcemay bend a component, which
would damage the system, or cause the system to be out of alignment.

Start with the top of the system and work down. Use slowmotions, in a straight line, from the back to
the front of the surface being cleaned. Change the cleaning wipe periodically to avoid re-depositing
material back onto the surface being cleaned. Allow all cleaned surfaces to dry completely before
restoring power to the system.



CE Mandated Warnings

Please read the following instructions carefully to prevent potential shock or fire hazards. This manual
should be retained for future use

Bitte lesen Sie die nachstehende Anleitung sorgfältig durch um Stromschlag und Feuergefahr zu
vermeiden. Diese Betriebsanleitung sollte für späteren Gebrauch sorgfältig aufbewahrt werden.

Preghiamo di leggere accuratamente, le sequenti Instruzioni, per evitare Prossiomi Incendi e Correnti.

Shock Hazard - Do Not Enter
Achtung Hochspannung - Nicht Berühren

Attenzione Corrent-Forte - Prego non toccare

The front panel’s switch is not the power disconnect device. The power cord should be removed after
use.

Der Kippschalter an der Vorderseite unterbricht nicht die Stromzuführung. Das Stromkabel sollte nach
Gebrauch aus dem Gerät herausgezogen werden.

L’interutore nella parete frontale non blocca le Corrente. La Corrente viene.

Never expose the unit to water or liquids. Avoid direct sun.
Bringe das Gerät nicht mit Wasser oder einer anderen Flüssigkeiten in Berührung. Vermeide direkte

Sonneneinstrahlung.
Evitare contatto con acqua oppure liquidi Infiammabili al Macchineggio. Auche entrate di Sole.



Do not insert any objects into the unit.
Keinen Gegenstand in das Gerät einbringen. Do non inseriamo any obietta into gli unità.

Non mettere ogetti dentro la Macchina.

Do not use near open flame or heat.
Das Gerät nicht in der Nähe einer offenen Flamme oder Hitze benutzen.

Non mettere la Macchina vicino a fuochi oppure Riscaldamenti.

The unit should never be enclosed or blocked.
Das Gerät darf nicht eingeschlossen oder blockiert werden.

La Macchina non chinderla per nessun motivo.

Connect unit only to a properly measured supply. Use only the three wire cord which is provided with
the unit.

Schließen Sie das Gerät nur an eine ordnungsgemäss vermessene Stromsversorgung an. Verwende nur
ein dreiadriges Kabel, wie es auch mit dem Gerät ausgeliefert wird.

Montare solo con misura normata. Adoperando solo 3 cavi elettrici cosi come e fornita la
Macchina.



Software Overview
The way that light reflects off a thin film is determined by the characteristics of the film, such as its
thickness, optical constants, and roughness. The F20 is able to determine thin-film characteristics by first
carefully measuring the amount of light reflected from the thin film over a range of wavelengths (i.e., by
measuring the reflectance spectrum), and then analyzing this data by comparing it to a series of
calculated reflectance spectra. Most of the features of the FILMeasure software that runs the F20 can be
divided into reflectance acquisition and reflectance analysis functions. The following pages outline the
main features of the FILMeasure software.

The basic steps for any F20measurement are selecting and editing the film structure, taking a baseline
measurement, and then making and evaluating themeasurement. The details of each of these steps are
explained below, followed by descriptions of other FILMeasure functions.

Measure Tab

1. Standard Windows menus, including; File, Edit, Setup, Acquire, and Help.

2. These tabs are used to select between theMeasure and Historywindows.

3. Displays the thickness of the film being solved for, as well as whether a sample is good or bad based on
the settings in the Alarms tab.



4. Allows the user toMeasure a sample, Baseline the system, or Analyze an open spectrum.

5. Users may select saved recipes from the drop-down list, or open the Edit Recipe dialog box.

6. This box provides more details about the calculated thickness, as well as any additional parameters
that were solved for, including Roughness, n and k, and Nonuniformity as well as theGoodness of Fit
(GOF).

7. Graphical display for spectra. A click of the right mouse button while the cursor is within the graphical
display opens the belowmenu for easy reading of cursor values in themain FILMeasure window. The
keyboard up/down and right/left arrows move themarker to a desired location.

The graph limits can be changed by double-clicking on the graph display. The text boxes along the
bottom of the graph control the wavelength range, in nanometers, displayed on the screen. The two on
the left represent the Reflectance (%) range, with themax being set in the upper box and themin being
set in the lower. The boxes on the right are for Transmittance (%)(requires the T-1 upgrade). Check the
Auto checkbox to activate y-axis autoscaling. The lower value is always 0 for autoscaling; themaximum y-
axis upper limit is 5000. The axes can be set to display in percent or as a decimal value (100% = 1).



Graph Options can be accessed and edited by double-clicking on the main graph window.

History Tab

1. Standard Windows menus, including; File, Edit, Setup, Acquire, and Help.



2. These tabs are used to select between theMeasure and Historywindows.

3. Used to alternate between the Single Measurement andMeasurement Trend tab. Selecting the
Measurement Trend tab will allow the user to see a plot of themeasurement results versus
measurement number.

When the Measurement Trend tab is selected in the Historywindow, the right side of the screens graphs the
results.

4. Shows themeasurement results for the selected spectrum (must be in Single Measurementmode).

5. Displays the selected spectrum (in Single Measurementmode).

6. Displays statistics for all measurements included in the history file.

7. This list contains all spectra currently included in the history file.

Edit Recipe Window
The Edit Recipewindow is used to define the film stack and to set analysis and acquisition parameters.



1. These buttons allow you to, in order from left to right:
i. Open a saved recipe.
ii. Start a new recipe.
iii. Save the current settings.
iv. Save the current settings as new recipe
v. Delete the current recipe.

2. Opens a drop-down list for quick access to saved recipes.

3. Author, as defined by user login name and recipemodification date is indicated here.

4. Allows the user to select between the Film Stack, Analysis Options, Alarms, and Acquisition Settings
tabs.

5. The desired thickness units are chosen here. The choices include angstroms (Å, 10e-10m), nanometers
(nm, 10e-9m), kilo-angstroms (kÅ, 10e-7m), microns (µm, 10e-6m), microinches, mils, millimeters (mm,
10e-3m), and Custom Units.

6. This is where thematerials and parameters to be solved are defined.



Editing Film Recipes
The description of the nominal film structure, as well as themeasurement parameters, is specified in the
Edit Recipe dialog box. Hundreds of different film structures and their measurement specifications may
be saved.

The Edit Recipe dialog box is accessed with the Edit Recipe... button on theMeasure Tab. The Edit
Recipe dialog box lists an initial guess at the specifications of the film structure to bemeasured. These
specifications include the number of films in the structure, the specifications of individual films (thickness
and index), and the film parameters to bemeasured.

Adding, Changing, or Deleting a Structure
When the Edit Recipe dialog box is opened, it shows the stored specifications of the structure selected
from the Recipe: list, along with any changes made since the recipe was loaded. Changes to the structure
selected can be permanently stored by making the desired changes and then clicking on Save. New
structures may be added to the Recipe: list by clicking on Save As. Similarly, a structuremay be deleted
(removed from the Recipe: list) by clicking on theDelete button.



Film Stack

The Film Stack tab is used to define the film structure and desired measurement units, as well as the
starting guesses and constraints for thickness, n and k. This is also where you determine your analysis
method, Grid, FFT, orNone, as well as any Nonuniformity that may be present in the sample. The [+]
and [-] above Composition, Thickness and Nonuniformity can be used to expand or hide solving
options.

Setting Up a Film Stack
When measuring a layer, the specifications (thickness, n, and k) of the known films (including the incident
medium and substrate)must be entered into the proper fields in the Edit Recipe dialog box, as well as
initial guesses for the values to bemeasured. The refractive index (n) and extinction coefficient (k) values
for common materials can be selected from the drop-down menus on the right-hand side of the listed
materials, or by left-clicking on thematerial and using the Search function. Note that if a generic index is
selected, the software will instead prompt for a new index value.

If a material is being measured is not present in thematerial library there are three possible approaches
to complete the recipe:



a) Choose a material in the library that is similar.
b) If thematerial is transparent (an insulator), select “Enter Refractive Index Value” from the
material list and enter a value for the refractive index (n will automatically be varied by FILMeasure
to account for dispersion effects, with the entered value being n at 632.8 nm).
c) Create a newmaterial file using the Edit>Material Library… dialog box. Enter the refractive index
values for n and k as a function of wavelength and save the files so that they may be selected as in
the recipe. See Creating and Editing n and k Files for more information.

Choosing the Films to be Measured
To measure a film's thickness, check theMeas box on the right-hand side of the Thickness field under the
Film Stack tab in the Edit Recipe dialog box. When no boxes are checked, the theoretical spectrum for
the specified layer stack and thicknesses will be displayed.

As with most measurements, the uncertainty of themeasured data increases as the number of
simultaneously measured values increases. Thus it is best to provide as much information about the film
structure as possible.

Constraints
By setting constraints, the user can limit the possible values of themeasured film properties. The
constraints are set in conjunction with the values entered in the Range dialog box for Thickness. For
example, if the initial guess of themeasured thickness of a film is 100 nm and the thickness constraint is
set at 50%, FILMeasure will only consider possible thicknesses in the range 50 nm to 150 nm. The
constraints for n and k are set using the n and k dialog boxes under Composition. These boxes are only
visible when the Thickness and Composition options are expanded.

You can select between constraining by a percent of the thickness guess, or by a selected thickness by
clicking on the % or measurement unit above the constraints dialog box. Constraining themeasurement
range can speed up analysis and can also help exclude non-physical solutions.

Custom Units
The Custom Unit function allows you to create your own custom unit for measurements if themetric
you'd like isn't already available in the drop-down list.

The Edit Custom Units dialog box.



To determine the correct coefficient to use, you must first know the relationship between your unit and
nanometers. For example, if your units aremg/ft2 and it's been determined that 1mg/ft2works out to a
film thickness of 150 nm, then you would calculate your coefficient as follows, where X is the coefficient.

Custom units can be saved as part of the Recipe file, and only one custom unit can be saved per recipe.

nk Model
When measuring the n and k of a film, the general dependence of these values upon wavelength must be
specified. This dependence is determined by the type ofmaterial to bemeasured. For example,
insulators, semiconductors, and metals all have a unique type of n and k wavelength dependence.

Dozens ofmodels for these different dependencies have been proposed and used over the years.
FILMeasure uses a few of themost versatile and accepted models. For insulators the Cauchy model is
used, for semiconductors either the Amorphous or Bridge-Lorentzian model, and for metals the Drude
model.

There are also a number of special-purposemodels for specific applications. Thesemodels, and starting
coefficients values, are selected automatically when a material is chosen from theMaterial lists in the
Edit Recipe dialog box. Other models may also be specified by selecting them from the nk Model drop-
down menu under the Composition tab which is accessed by right clicking on theMeas checkbox when
solving for optical constants is enabled.

Grid Search for Thickness
There are a number ofmethods that FILMeasure can use to determine thickness. Each is a different
trade-off between speed, accuracy, and robustness (i.e., the ability to find the best solution among many
that are nearly as good). Because thickness can vary over many orders ofmagnitude and many near-
solutions may exist, it is often best to use a very robust method to get close to the best solution, and
then let a more accuratemethod take over.

One very robust method is theGridmethod, which can be activated by selecting theGrid option in the
Refine via drop-down menu. TheGridmethod searches the entire allowed thickness range (as defined
by the initial guess and the constraints) to find the best initial thickness. However, on some very complex
multilayer spectra, it is possible for the Grid method to give the wrong answer. In such cases it is best to
use the Fourier Transform(FFT)method to determine initial thicknesses, or to provide them manually.



Fourier Search for Thickness
The FFT option in the Refine via drop-down list is an alternative option to let FILMeasure choose an
initial thickness for analysis. The Fourier Transform method analyzes the oscillations present in the
spectrum and determines the film thicknesses based on the periodicity of those oscillations. It is
generally somewhat less robust than theGridmethod, but is better at finding the correct thickness in
cases where the shape of the initial theoretical spectrum is different than themeasured data (i.e., the
reflectance spectrum is non-ideal in someway) or occasionally in cases where there is more than one film
thickness is being measured.

Nonuniformity

The Edit Recipe > Film Stack tab with the Nonuniformity option expanded.

Selecting this option enables modeling of thickness nonuniformity within themeasurement spot. An
initial guess forNonuniformitymust first bemade, and then solving can be enabled or disabled by
toggling theMeas box. If solving is not enabled, the software will assume the value provided for
nonuniformity.

Note: Solving for nonuniformity can greatly increase solving time.



Search

The Search Materials dialog box is accessible by left-clicking on a material name in the Edit Recipe > Film
Stack tab, or by selecting Search... from thematerial selection drop-down list.

Note: When clicking on a generic index file, the software will instead provide you with a dialog to enter a
new index value.

This feature allows the user to search for materials by using either thematerial name, or a keyword for a
certain class ofmaterials. The search function will also show a briefDescription of thematerial selected,
as well as any Synonyms or Keywords related to thematerial file. When files have a Synonym, that
means they are referencing the samematerial file under different names. So for example, if Silicon is



selected the file that will be shown in the Film Stack is Si, not Silicon, as that is the file both names are
referencing. The Similar Materials box will list any materials that may have similar optical properties.

Analysis Options

Correct setting of the following options will help ensure accuratemeasurements. Many of the options
are set automatically when film information is supplied in the Edit Recipe dialog box, and all of them can
be saved so that subsequent measurements can bemade as quickly and easily as possible. If Robust
(Adaptive; Thickness Only) or FFT (Thickness Only) is checked, only theData Selection settings will be
accessible.

Data Selection

Wavelength Range
This sets the wavelength range that is to be analyzed. It may be set as either the entire range displayed
on the graph or a fixed range as defined by the user. Wavelength rangemay also be changed by clicking
and dragging the ends of the gray bar near the bottom of the graph area in themain FILMeasure



window. Moving the bar will cause the software to reanalyze the data in the newly selected wavelength
range.

Smoothing
This function performs wavelength-dependent boxcar averaging on themeasured spectra. This can
improve signal-to-noise levels and can filter out oscillations that correspond to optical thicknesses
(defined as thickness * refractive index) equal or greater than the specified value. This value should be
lowered to increase smoothing, and raised to decrease smoothing. To eliminate smoothing, a very high
value (for example, 1000 μm) should be entered.

Source Data
If more than one data set is present, this option tells the software whether to analyze the 0 degree
reflectance data, transmittance data, 70 degree reflectance data, or some combination of the three.

Note: While every Filmetrics system is capable of opening and analyzing spectra with 70 degree
reflectance data, only the F10-RTA is capable of collecting this data.

Enable FFT (Thickness Only)
The FFT (thickness only) solver is one of three analysis methods available in the FILMeasure software.

This solver best suited for films greater than 250 nm thick, as well as multi-layered films. It is also an
effective option when the index of refraction of the film isn't well known. While this feature is selected
there will be fewer options under the Analysis Options tab. You cannot solve for index, roughness, or
nonuniformity with the FFT (thickness only) solver enabled. More information on the solver can be
found here.

Enable Robust (Adaptive; Thickness Only)
The Robust (adaptive; thickness only) solver is the second of three analysis methods available within
FILMeasure. It is best suited for measuring the thickness of single-layer films greater than 150 nm thick.

This method can oftentimes successfully measure films when the data is affected by non-ideal properties,
such as thickness nonuniformity, grading, and birefringence. Much like the FFT (thickness only) solver,
enabling Robust (adaptive; thickness only) will limit the options available in the Analysis Options tab.
You also cannot solve for roughness, nonuniformity or index with the Robust (adaptive; thickness only)
solver enabled.

Exact Spectrum Matching
The Exact Spectrum Matching is the third of three analysis methods available in FILMeasure. This solver
can be used to measure thickness, thickness nonuniformity, and roughness of single and multilayer
films, and can additionally solve for index.

Unmodeled Backside Reflections
When measuring films in transparent substrates, reflectance off of the backside of the substratemay
occur. Selecting Compensate for: Unmodeled backside reflections allows the software to shift the
intensity of the reflectance curve to account for the additional light. This feature should not be used
when measuring very thin films (< 100 nm).

http://filmetrics.com/thicknessmeasurement/f10-rt
http://filmetrics.com/thicknessmeasurement/f10-rt
../../../../../Content/SoftwareOverview/FastFourierTransformThicknessOnlyMode(FFTMode).htm


Tilted Sample/Lost Light
Samples with non-coplanar surfaces scatter some of the light away from the collection optics. This option
automatically compensates for the light lost due to nonplanarity.

Lock Identical Layers
Samples comprised of repeating layers can bemore accurately measured by activating this option. By
activating these options, all properties of any layers that initially have the samematerial or thickness are
locked together.

Analysis Options: Advanced

Advanced Analysis Options for Spectrum Matching.

Convergence Criteria
This sets theminimum GOF between themeasured and calculated spectra that is attained before the
measurement routines consider the solution final. In most cases a value of 0.999 is sufficient. For cases
where the desired GOF is not attainable, the value in theMaximum Iterations field limits the number of
iterations performed by the analysis routine.

Solver Cycles
This option will enablemultiple solver cycles, with the number of cycles being defined by the number
entered in the text box. When using this option, the software will run through themodel for a solution
once, and then try again starting from the solution previously found. This can help find the best solution
amongst a number of near-best solutions, which can be the case when solving for a large number of
parameters (several thicknesses and/or refractive index). A greater number of cycles will lead to a longer
solving time, however.



Display Details
This feature controls the wavelength at which n and k are displayed in theMeasurement Details portion
of themain screen. These values are only displayed if solving for n or k is selected in the Film Stack tab.

Advanced Analysis Options for FFT Analysis.

FFT Analysis Window
When the FFT solver is selected, the advanced options give you access to various settings to help
optimize analysis performance. When Optimize Position is selected, the solver will check for the best
possible GOF value in different areas across the spectrum in a wavelength range defined by the entered
window size. For example, if a window size of 200 nm is selected, the solver will look at six different 200
nm sections of the spectrum, and then select the range the provides the best GOF.

IfOptimize Size is selected, the solver will instead begin with a minimum window size as defined by the
user. It will then start at the center of the analysis range, and then extend equally in both directions six
times to find the best GOF. When Optimize Position and Size is selected, the software does both
functions, resulting in measuring thirty-one different combinations of location and analysis range.



Alarms

Minimum Valid GOF
Constraining theMinimum Valid GOF will excludemeasurements where the calculated GOF does not
reach the specified limit. Awarning or “Invalid” result will appear if the GOF constraint is not met. Specify
0 to have all solutions reported.

Activate Alarms
When Activate Alarms is selected, an alarm will trigger if themeasured thickness of the sample is outside
the specified Thickness Limits.

Thickness Limits
Setting theminimum and maximum allowable thickness limits will trigger an alarm if themeasured
thickness is outside the limits when Activate Alarms is selected.



Acquisition Settings

This menu lets the user controlMeasurement Timing, Spectrometer Type (on EXR and UVX systems),
Optics Configuration, and Advanced Acquisition Settings.

Measurement Timing

Use Recommended Sampling Time
Selecting this option uses the sampling time that has been automatically calculated by the software
during the baseline procedure. The displayed value is the total sampling time and not necessarily the
integration time. To see the integration time and number of integration cycles go to theHelp >
Diagnosticsmenu.



Use Maximum Sampling Time
Users can set a maximum sampling time by selecting this option. By increasing sampling time the user
may see a decrease in signal noise, but at the trade-off of a longer acquisition time.

Use Manually Set Parameters
Users can set the integration time per acquisition cycle and set a number of integration cycles over which
to average. When using this option, the total sampling time is equal to the integration timemultiplied by
the number of integration cycles.

To set the integration timemanually, set the sample on the stage and select Setup>Raw Signal… If the
proper integration time is unknown, an initial value of 40ms is a good starting guess. The vertical scale of
the spectrum extends from zero to 4095. Thus, a good working level is when the peak height of the
sample being measured, or the reflectance standard, whichever is greater, is 3000-3500 counts. (Note: if
the referencemeasurement saturates – Detector Saturation error – then spurious final measurements
will result.) If themaximum signal is too low, increase the integration time. Too large an integration time
will result in excessive dark current, so it is sometimes necessary to accept a smaller signal level to limit
the dark current.

Note: If the integration time is changed, it will be necessary to perform the baseline procedure, or re-
acquire the reflectance standard and background scans.

Spectrometer Type
EXR and UVX systems have two spectrometers (VIS/UV and NIR). Here the user can choose to use only
one or both spectrometers.



Optics Configuration

TheOptics Configuration dialog box is accessible through the Acquisition Settings tab under the Edit
Recipewindow. It is important to make sure that you remember to select the proper configuration for
your measurements in order to obtain the best possible results. Not all options are available with all
systems.



Advanced Acquisition Settings

Store Baseline settings in Recipe
This option allows the user to save the selected Optics Configuration, Baseline Name, and Reflectance
Standard used with each individual recipe.

Continuous Measure Settings
This option allows the user to set an interval, in seconds, between measurements when using the
Measure > Continuous Measure command from the Acquire Menu. By default this is set to 0.

Understand and Evaluating Measurement Results
This section covers information on theDisplay of Measured Spectra and a more in depth look at the
Goodness Of Fit value.

Display of Measured Data
Once film stack and measurement information have been entered and a baseline has been taken,
measurements may bemade by clicking on theMeasure button. After measurement, themeasured and
calculated reflectance spectra are displayed on the graph. The thicknesses of the films are listed in the
results box. If any of the thickness values weremeasured, they are displayed in bold numbers.

The quality and accuracy of the result is determined by howwell themeasured spectrum matches with
the calculated spectrum. In general, thickness information is determined by the number of oscillations,
and index information is determined by the amplitude of the oscillations. In the case of the Robust
(adaptive; thickness only) solver and Exact Spectrum Matching solver, a good result is one where the
minima and maxima of themeasured and calculated spectrum align. For the FFT (thickness only) solver,



this is when themeasured intensity peaks overlap. See theGoodness of Fit and Troubleshooting -
Thickness Modeling sections for more information.

Goodness of Fit
The accuracy of a calculation fit, and thus the reliability of themeasurement, can be judged by thematch
between themeasured and calculated spectra, which is quantified by the GOF value. GOF is a number
between 0 and 1.

A perfect match between measured and theoretical spectra will result in a GOF of 1. To ensure accurate
results the user may set a minimum acceptable GOF value by entering a number between 0 and 1 into
GOF Error on the Alarms Tab in the Edit Recipe dialog box. Awarning message will be displayed after
each measurement where the GOF falls below the user-specified GOF Error. If the GOF is less than 1 there
are several possible causes as follows:

a) Nonuniformity – Any variation of layer thickness, or presence of roughness, within the
measurement spot will result in a reduction in reflectance. In severe cases the interference peaks
may disappear entirely.

b) Incorrect Structure Definition – If the refractive index of one or more layers in the structure is
different from what is described in the layer structure, than there will be somemismatch between
the blue curve and the red curve.

c) Graded Interfaces – The amplitude of the peaks in the spectrum depends on both the size of the
change in refractive index at each interface in the layer structure and the sharpness of the interface.
For example, in many hardcoat samples there is some degree of layer intermixing at the interface,
leading to a weaker than expected reflectance at that interface. In severe cases the peaks may
disappear entirely.

Window Menu Items
This section describes the various functions available through the standard Windows FileMenus.

File Menu

Edit Menu

Setup Menu

Acquire Menu

Help Menu



File Menu

Open Spectrum… (Measure Tab only)
This command is used to open stored reflectance spectra, which are then displayed and can be analyzed
for film properties.

Open Measured Template… (Measure Tab Only)
This command is used to open a saved Contact Probe TemplateMode file.

Note: Contact probe mode must be enabled in the Optics Configuration.

Open History…
Previously saved history data containing measurements and statistics can be loaded with this command.

Import: Recipe…
To import recipes that were previously exported, or created with an older version of FILMeasure, use this
command.

Import: Material…
Custom materials, either created by the user or provided by Filmetrics, can be imported using this
command.

Import: License…
When the user purchases an upgrade for the system, Filmetrics will send a license file to the user. The
licensemust be imported into the software before upgrades are effective.

Save Measured Spectrum… (Measure Tab only)
This command is used to save spectra for export or later analysis. All data is saved along with the
corresponding wavelength data in comma-delimited format. Files can be saved in four different formats:

*.fmspe: This file can only be opened in FILMeasure 5.0 or greater and is the preferred way to save
spectra. Additional information from data acquisition is stored in this file.



*.spe: This file can be opened in all versions of FILMeasure.

*.csv: This is a comma-delimited file that can be opened directly in Excel.

*.txt: This is a tab-delimited file, and can be opened with a text editor.

Save Screen to File… (Measure Tab only)
This command takes a screenshot of the FILMeasure window.

Save n and k to files… (Measure Tab only)
This command is used to save the calculated n and k data to its own material file for use in the Edit
Recipe>Material list boxes. All data is saved along with the corresponding wavelength data in comma-
delimited format.

Note: This option is only present when optical constants are being solved for.

Export: Recipe…
Recipes can be exported for use on other computers running FILMeasure. The exported file will also
automatically include any material files required by the recipe. To duplicate an analysis, all that is needed
is the exported recipe and the spectrum being analyzed.

Export: Recipe for FILMeasure 4…
This command will convert a recipe for use with FILMeasure 4. This will not includematerial files or recipe
features only available in FILMeasure 7.

Export: SystemInfo File…
For certain upgrade purchases that can be done through software, the user will be required to send the
SystemInfo file to Filmetrics, which can be exported using this command.

Edit Menu

This menu allows access to theMaterial Library.

Material Library
Thematerial library is used to display information about existing materials as well as create new ones.
Material files shipped with FILMeasure have the file extension “.fibnk” and will only display limited
information. User created material files can be plotted on a graph or viewed in table form.



A newmaterial may be entered into thematerial library manually if refractive index (n) and extinction
coefficient (k) are known as a function of wavelength for the newmaterial.

To create a newmaterial file:

a. Select Edit>Material Library…menu item. The Edit Material dialog box will appear.

b. Click New… to create a newmaterial.

c. Select the type ofmaterial you are ready to create (Dielectric, Photoresist, Semiconductor, Metal,
or Other).

d. Optimize the functionality of the file by entering index values over the entire wavelength
spectrum of the system. The wavelength unit is nanometers. Enter index information every 20 to 50
nm, depending on the complexity of the data. In areas where n or k is quickly changing, more
densely spaced the points should be entered.

e. Alternatively, select theModel>Custom radio button and click theDetails button. A Custom
Model Information dialog box will appear. Select the appropriatemodel. Enter in the known
coefficients and click OK. Cauchy coefficients are displayed in microns. If they are entered in Å,
FILMeasure will automatically detect this and convert them to microns.

f. Click the save button to save thematerial. You will be asked for a file name, and you may select
one of two file types:
*.fitnk: Compatible with FILMeasure 5 and beyond.



*.nnn: Creates a *.nnn file and, if there is k in thematerial, a *.kkk file to contain material data. For
files with both n and k, the two files must have the same filename, xmaterial.nnn and xmaterial.kkk
for example, in order for FILMeasure to properly indentify them. Compatible with FILMeasure 7 and
earlier.

Setup Menu

This menu contains the settings for manually obtaining the Standard/Background information, Display
options, and the Raw Signal dialog. This is also where user access can be set through the Access Control
option, as well as modifying some system Options.

Standard/Background
This control is used when manually taking and enabling/disabling Reflectance Standard and Background
compensation.

Take Standard
This button allows the reflectance standard portion of the baselinemeasurement to be taken without
having to re-take the background measurement.

Take Background
This button allows the background portion of the baselinemeasurement to be taken without having to
re-take the referencemeasurement.

Use Standard
This checkbox allows the reflectance standard portion of the baseline correction to be enabled or
disabled. This box is only available if a baseline has already been completed.



Subtract Background
This checkbox allows the background subtraction portion of the baseline correction to be enabled or
disabled. This box is only available if a baseline has already been completed.

Display

Color Measurement Settings: Color Space
The color of a spectrum can be displayed and quantified on themain screen if a color space coordinate
system is selected.

When a Color Space is selected, the color of the spectrum and the coordinates appear on the main FILMeasure
window.

Color Measurement Settings: Observer
When a specific color space is chosen for display, this option allows the user to choose between the CIE
1931 2 degree observer and the CIE 1964 10 degree observer. Note that this variable is associated with
the CIE eye-response convention (see, for example, http://en.wikipedia.org/wiki/CIE_1931_color_
space) and is unrelated to the illumination or collection angle of themeasurement.

Color Measurement Settings: Illuminant
This setting refers to the standard illuminant being used by the software to help determine the results of
the color analysis.

http://en.wikipedia.org/wiki/CIE_1931_color_space
http://en.wikipedia.org/wiki/CIE_1931_color_space
http://en.wikipedia.org/wiki/CIE_1931_color_space
http://en.wikipedia.org/wiki/CIE_1931_color_space
http://en.wikipedia.org/wiki/Standard_illuminant
http://en.wikipedia.org/wiki/Standard_illuminant


Color Measurement Settings: Fixed Luminance
The user can fix the luminance of the displayed color. Since antireflective coatings, for example, are
inherently transmitting, the spectra has very little luminance and the coating color may appear black on
screen. Fixing the luminance does not affect the color space coordinate results.

Spectrum colors of the same spectrum with fixed luminance of 10%, 40%, and 70%, respectively.
Note that fixing the luminance to view the color does not affect the color space coordinate values.

Number of Spectra
This sets themaximum number of spectra displayed simultaneously on themain FILMeasure screen. If
themaximum number of spectra is reduced to fewer than the number already on the screen, themost
recently selected spectra will remain.

Spectra Transformation
On spectra where reflectance and transmittance information is present you can have the software
display them as separate spectra (none), added together (sum), or the absorptance (1-R-T).

Graph Options
The background of the graph can be set to white or black using this option, as well as allowing the
software to auto-position the legend box to avoid or minimize overlap with the displayed spectra.

Measurement Results: Significant Digits
The user can select the number of significant figures, from 1 to 7, that the results are displayed in. For
example with the units set to Angstroms, if a result of 7213 Åwill be displayed for 4 significant digits, it will
be displayed as 7210 Å for 3 significant digits.

Displayed Controls
These checkboxes are used to determine which controls are listed on the right hand side of the
FILMeasure window.

Access Control
The software for the instrument incorporates password protection to limit access to themeasurement
software and settings. When the software is initially installed the access control is turned off. The
software will automatically boot up with Engineer level access that enables access to all features of the
program except turning on and off access control and adding and deleting users.



Turning on access control requires Supervisor level access. The software is delivered with one user, a
supervisor, in the list of authorized users as shown below:

UserID: filmsuper

Password: filmetricsfff

To turn on access control, log in as filmsuper using the password shown above. The Activate Access
Control checkbox should now be enabled. By placing a check mark in the Activate Access Control
checkbox access control will be active. User ID and Password are case-sensitive.

To add an operator level user, select operator from the Access Level list box, type a user name and type
an initial password for that user. Then click the Add User button. To add an engineer or a supervisor user
follow the same procedure, but pick the appropriate access level from the list box before pressing the
Add User button.

To delete a user, enter theUserID and press theDelete User button.

Operator and Engineer level users can change their passwords when they are logged in by entering their
password into the password box and pressing the change button. Supervisor-level users can change
their password or the password of any other user by selecting the appropriate access level, entering the
appropriateUserID and the new password and pressing Add User. If the program finds that a user
already exists, it will delete the old entry for that user and create a new entry.

We recommend that you create a new supervisor level user and delete the filmsuper user for maximum
security. If all supervisor level users forget their passwords, it will be necessary to re-install the software
and add all the users again.



Raw Signal

Raw Signal
The Raw Signal dialog box allows the user to plot the raw (no baseline corrections applied) spectrometer
signal on themain graph. No spectral smoothing is applied, and there are no saturation warnings. This is
useful when adjusting the focus or when setting integration times manually.

Active Spectrometer
For systems with multiple spectrometers (EXR and UVX) these radio buttons allow you to select between
collecting data from the short wavelength, long wavelength, or both spectrometers.

Integration Time
This sets the integration time of the spectrometer. Clicking Update Recipe transfers the listed integration
time to the current recipe.



Start/Stop
This button starts/stops the acquisition of the spectrometer signal.

Graph Limits
This allows the user to either manually set or autoscale the graph limits.

Options

TheGeneral Settings tab is used to enable, disable, and modify various options in the software. The
Selected Camera pull down menu allows the user to enable the Sample Cam on equipped systems, or
choose between different cameras if there is more than one attached to the system. The Reference
Signal Thresholds options are used by the software during the Baseline process. If, during the Acquire
Reference step of the Baseline, the intensity of the reflectance standard goes above or below the
percentages listed an error message will appear.



TheData Recording tab allows for automatic saving of all spectra and results to a central file. The user
can also select between having the software provide a prompt for which data to include in the history file
when using Acquire>Continuous Measure or to include all measurements to history.

Clicking the Contact Probe Template Mode enables the template function on themain FILMeasure
window. For more information on creating and using templates, see Contact Probe Template Mode in
the Advanced Features section. This check box is only accessible if contact probe is selected underOptics
Configuration.



Acquire Menu

Acquire > Acquire One Spectrum
This function collects a single spectrum and displays it on the screen. No analysis is performed until the
recipe is changed or the Analyze button is clicked.

Acquire > Acquire Continuously
This feature collects real-time data from the spectrometer. It is useful when searching for a specific
location to measure (for example, locating a more uniform area of the sample, or one that exhibits
interference fringes).

Acquire > Measure Once
This feature collects a spectrum, analyzes it and displays it on the screen. This is the same as pressing the
Measure Button. For systems with the Sample Cam, this saves an image to the spectrum file created.

Acquire > Measure Continuously
This feature collects real-time spectrum data and analyzes it – similar to repeatedly pressing theMeasure
button. Ameasurement interval time can be set in the recipe using the Advanced options underneath
the Acquisition Settings tab.

Batch Acquire
The Batch functions allow you to act on groups of spectra, rather than each individual spectrum

Acquire > Batch > Acquire
This option allows you to acquire a pre-selected number of spectra. You can also choose to save the
batched spectra as they are acquired.



Acquire > Batch > Measure
This option allows you to acquire and analyze a pre-selected number of spectra. You can also choose to
save the batched spectra as they are acquired.

Acquire > Batch > Analyze Spectra
This option allows the user to select multiple spectra for analysis by the current recipe. If there aremore
spectra to be analyzed than the software is set to Display, the analyzed spectra can easily be retrieved
from theHistory tab.

Acquire > Batch > Analyze All Spectra in Folder
This option will analyze every spectrum in a folder with the currently selected recipe. If there aremore
spectra to be analyzed than the software is set to Display, the analyzed spectra can easily be retrieved
from theHistory tab.

Help Menu

Diagnostics
The diagnostics window gives information regarding the data taken during the baseline. Reference and
background counts are shown (this is useful to see howmuch signal the system is getting; good signals
typically are between 2500-3500 counts).



Help>Diagnostics shows the user information regarding the data taken during the baseline routine.

Help > About FILMeasure
Information about the hardware and software versions and the system serial number can be found here.
Please have this information available when calling Filmetrics for technical assistance.



Help>About FILMeasure... window

Taking a Baseline
The baselinemeasurement allows the FILMeasure software to take into account the response inherent
to the reflectancemeasurement hardware. It does this by first measuring the sample reflectance, then a
reflectance standard, and finally by taking a “dark” reading. The light source should be allowed to
stabilize at least fiveminutes before the baseline is taken. When measuring films less than 1000 Å thick,
the baseline should be periodically re-taken every 20-30minutes. For thicker films, a new baseline can be
taken less often.

Baselinemeasurements may be started two ways:

1. Select the Baseline button, which will guide the user through the baseline procedure, or

2. Select Set Up>Standard/Background... from themenu bar for manual access to the baseline functions.

The following instructions assume the user has already focused the system, if necessary, and clicked the
Baseline button. For instructions on focusing the system, see Focusing the Fiber.



The first step of the baselinemeasurement is to acquire a spectrum of the sample. This is done by placing
the sample on the stage underneath the light path. This step is used by the software to help determine
the needed integration times and cycles to best measure the sample.

The next step is to take a spectrum of a reflectance standard. This done by placing a reflectance standard
of similar reflectance to the test sample on the sample stage. The reflectance standard that is used
should be selected from the Reflectance Standard: list. For reflectance standards not in the list,
reflectance versus wavelength values may be entered into a comma-delimited text file with the extension
“.rrr” (stored in thematerial subfolder). As discussed in the focusing section, when using a stage or lens
assembly, it is important that the top of the sample and reference are roughly the same height to insure
that the light is properly focused on both.

Themethod the background measurement is taken is dependent on the optical set-up. If using the SS-3
or SS-4 in reflection mode, simply remove the reflectance standard from the stage and click Take
Background. Both stages have a small angled piece of glass built into the stage to deflect away the light.
For transmission mode, the collection optic must be covered using an opaque object. If using a contact
probe, the probe needs to be pointed away from any light source or reflective surface.

After acquiring a baseline, the instrument is ready to begin making measurements. To verify that the
system is working properly, select Acquire One Spectrum from the Acquiremenu with the reflectance
standard in place. You should see the reflectance spectrum of the reflectance standard.

Autobaseline

When theOptics Configuration is set to the contact probe or contact stage, the Autobaseline option
can be selected. This option will automatically perform a baseline periodically, so that the user does not
have to do this routinely. Once selected, the Baselinemeasurement routinementioned above will only
require the user to measure the BK7 reflectance standard and take a dark reading. A user will only have
to do a manual baseline once per week.

Fast Fourier Transform Mode (FFT mode)
The FFT mode tends to bemore robust when measuring very thick films or thick multi-layer stacks,
where the total thickness is greater than 5microns.

To activate FFT mode, select the select FFT (thickness only) button located on the Analysis Options >
Analysis Method tab in the Edit Recipe box.



The Measure Tab shows a split screen with the measured spectrum on the top graph and the FFT spectrum on the
bottom graph.

In FFT mode, instead ofmatching themeasured reflectance spectrum with a calculated reflectance
spectrum, FILMeasure identifies the peaks in the FFT Spectrum and uses them to compute the layer
thicknesses. The number of possible FFT peaks is n*(n+1)/2 where n is the number of layers. Thus, for a
two layer structure, we expect to see three peaks in the FFT spectrum.

The image above shows the screen just after measurement of a two layer stack using FFT mode. The
upper graph shows a blue curve representing the reflectance spectrum of the sample. The lower graph
shows a blue and red FFT spectrum. The blue FFT spectrum is computed from themeasured reflectance.
The red FFT spectrum is computed from the theoretical reflectance spectrum of a layer stack with the
measured layer thicknesses. The small side lobes visible on either side of the two tall peaks are artifacts of
the FFT process and can generally be ignored. The only time the side lobes will cause a problem is if a
weak peak from a multi-layer sample is very close to a much stronger peak. If this case occurs
FILMeasuremay lock onto one of the side lobes by mistake and it may not be possible to measure the
layer thickness associated with the weak peak. Reducing the Constraint range and/or increasing the
guess for the thickness for the layer with the weak peak may be helpful in getting FILMeasure to lock
onto the weak peak. If the peak is too weak to reliably measure it is best to change the layer structure
definition so that the layer corresponding to the weak peak is eliminated.

Along with themeasured layer thicknesses, the Results text box displays important information about
themeasurement. This important information includes theGoodness Of Fit (GOF) and a description of
which peaks were used to determine themeasured layer thicknesses. In the figure above layer 1



thickness is determined based on the position of the peak located at 4.780microns and layer 2 thickness
is determined using the peak corresponding to layers 1+2 (7.011microns). Notice that the thickness of
layer 2 is not exactly equal to 7.011-4.780 = 2.231microns. FILMeasure computes a thickness for layer 2 of
2.113microns because it precisely accounts for the fact that layer 2 has a different refractive index than
layer 1.

Discussion of GOF:

A perfect match between measured and theoretical FFT spectra will result in a GOF of 1. To ensure
accurate results the user may set a minimum acceptableGOF value by entering a number between 0 and
1 into GOF Error on the Alarms settings in Edit Recipe. A warning message will be displayed after each
measurement where theGOF falls below the user-specified GOF Error. If theGOF is less than 1 there are
several possible causes as follows:

a) Nonuniformity – Any variation of layer thickness within themeasurement spot will result in a
reduction in the FFT peak heights. In order to permit easy visual interpretation of the FFT results
FILMeasure always scales the amplitude of the red curve so that it matches the blue curve.
However, if the scaling factor is not 1.0, FILMeasure reports a reduced GOF even if the red curve
appears to exactly match the blue curve on the screen.

b) Incorrect Structure Definition – If the refractive index of one or more layers in the structure is
different from what is described in the layer structure, then the FFT peak amplitudes in the blue
curve will not match the peak heights in the red curve. The software will attempt to scale the red
curve, but if there is more than one FFT peak present, the scaling will only result in one correct peak
height. If you wish to view the impact of changing the refractive index of one or more layers, simply
change the refractive index in the Edit Recipe dialog box and click Analyze. If there is only a single
layer you will notice that the GOF will change, but the red curve should not changemuch. If there
aremultiple layers in the structure you will notice that the relative peak heights in the red curve will
change when you click Analyze.

c) Graded Interfaces – The amplitude of the peaks in the FFT spectrum depends on both the size of
the change in refractive index at each interface in the layer structure and the sharpness of the
interface. In many common samples you will find that there is some degree of layer intermixing at
the interface, leading to a weaker than expected reflectance at that interface. The FFT peak(s)
associated with the intermixed interface will suffer a reduced amplitude and in severe cases the
peaks may disappear entirely.



Making Measurements
Accuratemeasurements with the F20 rely on using the proper measurement setup. The basic steps for
any F20measurement are:

1) Selecting and editing the type of film to bemeasured
2) Taking a Baselinemeasurement
3) Clicking on theMeasure button to acquire and analyze themeasured spectrum.

Each example belowwill take you through this sequence of steps. In each example it is assumed that the
hardware has been set up as described in theQuick Start Guide, and that you have first read through
the Software Overview section to familiarize yourself with the basic controls.

TheMeasurement Assumptions, Hints for Improved Accuracy, and Troubleshooting sections describe
techniques that should be followed for themost accuratemeasurements.

Focusing the Fiber
When the fiber-optic is fully inserted into the lens tube, the SS-3 is designed to provide optimal focus for
subjects the same height as the silicon reflectance standard. If the object to bemeasured is a different
height than the Si wafer please follow the procedure below to focus the fiber-optic.
Instructions for focusing for maximum signal are as follows:

A. Turn on the light source and start the FILMeasure program.

B. Go to the Set Up>Raw Signal… dialog box and set the integration time for 30milliseconds and
click Apply.

C Place a reflective sample, such as a silicon reflectance standard or BK7 reflectance standard on the
sample stage. You will now see the raw signal from the image sensor. If the signal saturates, reduce
the integration time (step B).

* * Note * * Focus position is dependent on subject height. Make sure the surface you intend
to measure is at the same height as the reflective sample.

E. Optimize the focus to maximize themeasured signal by adjusting the fiber-optic cable position in
the lens tube. To achieve this, move the fiber-optic cable slightly up the lens tube until maximum
signal is obtained.

The screw on lens tube is actually a spring-loaded ball plunger and does not require tightening.
Users should be aware that the fiber may slip out of focus if the stage or cable is moved. If one focus
height is often used, the set screw can be tightened to reduce the chance of inadvertent slipping.

F. Close the Set Up>Raw Signal… dialog box. Focusing is now complete.



* * Note * * When performing the baseline procedure, always make sure the top surface of the
reference material is at the same height as the sample surface you intend to measure.

There is also a video demonstration of this procedure on YouTube, which can be found here. An active
internet connection will be needed to view the video.

Measuring Thickness
Examples that describe themost common measurement setups are described in this section.

Example 1: Measuring Single Layer Films.

Example 2: Measuring Multi-Layer Films.

Example 3: Measuring Films on Transparent Substrates.

Example 4: Transmittance Measurements.

Example #1: Measuring Single Layer Films
For this example wewill demonstrate themeasurement of SiO2 on Silicon using the TS-SiO2-4-7200
thickness standard provided with the system. This type ofmeasurement does apply to an extremely
broad range of applications, including hardcoats, polysilicon, and LCD cell gaps to name just a few.

Hardware:
If the sample to bemeasured is flat, any standard or rotating sample stage will work fine. If the sample is
curved, or is transparent with films on its backside (such as ophthalmic lens applications), a hand-held
contact probemeasurement device (e.g., CP-1-1.3) may be necessary.

Step 1: Select the film recipe
Select the film structure to bemeasured, in this case “SiO2 on Si”, from the Recipe: list box on themain
screen. If the structure to bemeasured does not exist, a new structuremust be defined. See Editing Film
Recipes for more details.

Step 2: Edit the film recipe
To edit the film stack, click the Edit Recipe... button to open the dialog box. Check to see that the film
stack matches that of the actual sample. If not, different films can be selected using either the drop down
menu next to thematerial or the Search function. This is also where you can enter a starting guess for
thickness as well as the desired constraint range.

http://www.youtube.com/watch?v=RebzoBfonEk


Example Edit Recipe>Film Stack window

For this example, we'll use 10000 angstroms as theNominal thickness, with a constraint range of 100%.
Make sure that the SiO2 layer thickness is being solved for by clicking the checkbox underMeas. The
substrate should be set to Si. Underneath the Analysis Options tab, set the Analysis Method to Exact,
with nothing else enabled. Click OK to confirm the changes to the recipe.

Step 3: Take a Baseline Measurement
Take a baselinemeasurement by first clicking on the Baseline button on themain screen. A dialog box
will appear to step you through the process. Follow the steps on screen, and be sure to match the
material selected with the reflectance standard that will be used. For this example use the Si reflectance
standard.

Step 4: Make the Measurement
Make themeasurement by placing your sample on the stage (or the contact probe on your sample) and
click on theMeasure button. If you're finding it difficult to align the test spot under the light path, a
diffuse reflector like a piece of paper or business card can be used to help.



FILMeasure will then acquire the reflectance spectrum and calculate the corresponding thickness. If the
measurement was successful, theminima and themaxima of the calculated reflectance (the red line on
the graph) will coincide in wavelength with theminima and themaxima of themeasured reflectance (the
blue line on the graph). In most cases they will not overlap, but will be separated in amplitude.

Measured and calculated reflectance spectra when measuring the thickness of SiO2 on silicon.

If the calculated (red) and measured (blue)minima and maxima do not coincide, then themeasurement
was not successful. There are several possible causes of an unsuccessful measurement. Themost
common for this type ofmeasurement are described in Cases #1, #2, and #3 in the Troubleshooting
section.

Example #2: Measuring Multi-Layer Films
This example demonstrates themeasurement multi-layer films using the VIS-AR reflectance standard.
This type ofmeasurement has a broad range of other applications, most commonly optical coating and
flat-panel display process films.

Hardware:
If the sample to bemeasured is flat, any standard or rotating sample stage will work fine. If the sample is
curved, the hand-held contact probe (e.g., CP-1-1.3) may be necessary.

Step 1: Select the film recipe
Select the film structure to bemeasured, in this case “VIS-AR Thickness Standard”, from the Recipe: list
box on themain screen. If the structure to bemeasured does not exist, a new structuremust be defined
see Editing Film Recipes for more details.



Example Edit recipe>Film Stack window for measuring the VIS-AR Reflectance Standard.

Step 2: Edit the film recipe
To edit the film stack, click the Edit Recipe... button to open the dialog box. Check to see that the film
stack matches that of the actual sample. If not, different films can be selected using either the drop-down
menu next to thematerial or the Search function. If there are fewer layers present in the recipe than
there are in the film stack, additional layers can be added with the + buttons on the left hand side. The X
buttons can be used to remove additional layers if there are too many present. This is also where you
can enter a starting guess for thickness as well as the desired constraint range.

For this example, we'll use 83 nm as theNominal thickness for the first layer, 100 nm for the second, 30
nm for the third and 20 nm for the forth. When solving for multiple layers, it is suggested to use smaller
constraints ,35% in this case, to help improve solver speed and accuracy. Make sure that the layer
thicknesses are being solved for by clicking the checkboxes underMeas. The substrate should be set to
BK7. Underneath the Analysis Options tab, set the Analysis Method to Exact, with nothing else
enabled. Click OK to confirm the changes to the recipe.

Step 3: Take a Baseline Measurement
Take a baselinemeasurement by first clicking on the Baseline button on themain screen. A dialog box
will appear to step you through the process. Follow the steps on screen, and be sure to match the



material selected with the reflectance standard that will be used. For this example use the BK7 reflectance
standard.

Step 4: Make the Measurement
Make themeasurement by placing your sample on the stage (or the contact probe on your sample) and
click on theMeasure button. FILMeasure will then acquire the reflectance spectrum and calculate the
corresponding thickness. If themeasurement was successful, theminima and themaxima of the
calculated reflectance (the red line on the graph) will coincide in wavelength with theminima and the
maxima of themeasured reflectance (the blue line on the graph). In most cases they will not overlap, but
will be separated in amplitude.

Measured and calculated reflectance spectra when measuring the thickness of the VIS-AR Reflectance Standard.

If the calculated (red) and measured (blue)minima and maxima do not coincide, then themeasurement
was not successful. There are several possible causes of an unsuccessful measurement. Themost
common for this type ofmeasurement are described in Cases #1 and #2 in the Troubleshooting section.

Example 3: Measuring Films on Transparent Substrates
In this example wewill demonstrate themeasurement of hardcoat on acrylic using the TS-Hardcoat-
Trans thickness standard. This type ofmeasurement does apply to an extremely broad range of
applications, including packaging films

Hardware:
For this type ofmeasurement the samplemust be flat, with the front and backsides parallel.



Step 1: Select the film recipe
Select the film structure to bemeasured, in this case “HC Standard on Acrylic - Trans”, from the Recipe:
list box on themain screen. If the structure to bemeasured does not exist, a new structuremust be
defined. See Editing Film Recipes for more information.

Step 2: Edit the film recipe

Example Edit Recipe>Film Stackwindow for measuring the thickness of a film on a transparent substrate

To edit the film stack, click the Edit Recipe... button to open the dialog box. Check to see that the film
stack matches that of the actual sample. If not, different films can be selected using either the drop-down
menu next to thematerial or the Search function. This is also where you can enter a starting guess for
thickness as well as the desired constraint range.

For this example, we'll assume themeasurements are being taken on a SS-3 stage. Set theNominal
thickness at 6microns, with a constraint range of 75%. Make sure that the HC Standard - 2 layer
thickness is being solved for by clicking the checkbox underMeas.



The second layer should be Acrylic - 2 with a thickness of 2000 μm, or 2mm, with Air as the substrate. Do
not enable solving for the Acrylic - 2 layer. This lets the software know that there is a finitely thick layer of
acrylic, so that it will accurately account for back reflections. If you're using the contact probe or contact
stage to takemeasurements, you can simply set the substrate Acrylic - 2 and enable account for backside
reflections under the Analysis Options tab. Click OK to confirm the changes to the recipe.

Step 3: Take a Baseline Measurement
Take a baselinemeasurement by first clicking on the Baseline button on themain screen. A dialog box
will appear to step you through the process. Follow the steps on screen, and be sure to match the
material selected with the reflectance standard that will be used. For this example use the BK7 reflectance
standard.

Step 4: Make the Measurement
Make themeasurement by placing your sample on the stage (or the contact probe on your sample) and
click on theMeasure button. FILMeasure will then acquire the reflectance spectrum and calculate the
corresponding thickness. If themeasurement was successful, theminima and themaxima of the
calculated reflectance (the red line on the graph) will coincide in wavelength with theminima and the
maxima of themeasured reflectance (the blue line on the graph). In most cases they will not overlap, but
will be separated in amplitude.

Measured and calculated reflectance spectra when measuring the TS-Hardcoat-Trans.

If the calculated (red) and measured (blue)minima and maxima do not coincide, then themeasurement
was not successful. There are several possible causes of an unsuccessful measurement. Themost
common for this type ofmeasurement are described in Cases #1, #2, and #3, in the Troubleshooting
section.



Example 4: Transmittance Measurements
In this example wewill demonstrate the acquisition of a transmittance spectrum. Modeling the data
remains the same as with reflectancemeasurements, though analyzing the transmittance data needs to
be enabled under Analysis Options > Source Data in the recipe.

Hardware:
For this type ofmeasurement the samplemust be flat, with the front and backsides parallel. A standard
sample stage equipped with the T-1 transmission option is required. When measuring very thin films,
use of a vacuum plugged into the vacuum port is recommended.

Step 1: Specify Transmittance Configuration
Set theOptics Configuration to Standard Stage - Transmittance in the recipe under Acquisition
Settings>Optics Config.

Optics Configuration dialog box.



Step 2: Take a Baseline Measurement
Take a baselinemeasurement by first clicking on the Baseline button on themain screen. A dialog box
will appear to guide you through the process. The first step will be a measurement of the reference
material. Air will be used as our referencematerial. Select “Enter constant…” from the drop-down list,
enter a refractive index of “1” and remove all objects from the light path. The second step is a
background measurement. Place an opaque object over the bottom fiber on the state. No light should
enter the fiber during themeasurement.

Click “Finish” to complete the baseline procedure.

Step 3: Make the Measurement
Make themeasurement by placing your sample on the stage. Under the Acquire>Single Acquire from
themenu bar.

Single Acquire collects the measured spectrum (blue curve) off of the sample.

Measuring Thickness and Refractive Index
The following example describes themost common setup for index and thickness measurement.

Example 1: Measuring Thickness and Optical Constants of a Film.



Example 1: Measuring Thickness and Optical Constants of a Film
For this example wewill demonstrate themeasurement of Si3N4 on silicon but this type ofmeasurement
has an extremely broad range of applications, including themeasurement of oxides, polysilicon, and
optical coatings.

Hardware:
Any standard or rotating sample stage should work fine. The sample frontsidemust be flat. If the sample
backside is not flat or parallel with the frontside, then the contact stagemust be used.

Step 1: Select the film recipe
Select the film structure to bemeasured, in this case “Si3N4 on Si”, from the Recipe: list box on themain
screen. If the structure to bemeasured does not exist, a new structuremust be defined. See Editing Film
Recipes for more details.

Step 2: Edit the film recipe
To edit the film stack, click the Edit Recipe... button to open the dialog box. Check to see that the film
stack matches that of the actual sample. If not, different films can be selected using either the drop-down
menu next to thematerial or the Search function. This is also where you can enter a starting guess for
thickness as well as the desired constraint range.

Example Edit Recipe>Film Stackwindow for measuring the thickness, n, and k of films on an opaque substrate.



For this example, we'll use 300 nanometers as theNominal thickness, with a constraint range of 25%.
None should be selected underneath the Refine via drop-down list. Make sure that the Si3N4 layer
thickness is being solved for by left clicking the checkbox underMeas.

We'll also have to enable optical constants solving under the Composition options. These options
should be visible by default, but if they are not they can be accessed by clicking on the [+] underneath
Composition in the Film Stack tab. Left click on theMeas. button to enable optical constants solving,
and set the constraints for both n and k at 5. We'll also want to confirm that the correct model is
selected. Right click on theMeas. button to access the nk model drop-down list, and select the Si3N4
model. For more information on optical models, see nk Model.

The substrate should be set to Si. Underneath the Analysis Options tab, set the Analysis Method to
Exact, with nothing else enabled. Click OK to confirm the changes to the recipe.

Step 3: Take a Baseline Measurement
Take a baselinemeasurement by first clicking on the Baseline button on themain screen. A dialog box
will appear to step you through the process. Follow the steps on screen, and be sure to match the
material selected with the reflectance standard that will be used. For this example use the Si reflectance
standard.

Step 4: Make the Measurement
Make themeasurement by placing your sample on the stage and click on theMeasure button.
FILMeasure will then acquire the reflectance spectrum and calculate the corresponding thickness and
optical constants. If themeasurement was successful, the calculated reflectance (the red line on the
graph) will coincide with themeasured reflectance (the blue line on the graph).

If themeasured and calculated spectra do not fall on top of each other, the resulting thickness, n, and k
values are incorrect. If themismatch between measured data and calculation is only slight, the results
reported will only be off by a small amount. If themeasured and calculated spectra match, but the
results are implausible theremay be a problem with the sample positioning and light collection. Causes
and corrective actions to improve themeasurements are listed in Cases #4 and #5 in the
Troubleshooting section.



Measured and calculated reflectance spectra when measuring the thickness, n, and k of Si3N4 on silicon

Measuring Thickness
Examples that describe themost common measurement setups are described in this section.

Example 1: Measuring Single Layer Films.

Example 2: Measuring Multi-Layer Films.

Example 3: Measuring Films on Transparent Substrates.

Example #1: Measuring Single Layer Films
For this example wewill demonstrate themeasurement of SiO2 on Silicon using the TS-Focus-SiO2-4-
10000 thickness standard provided with the system. This type ofmeasurement does apply to an
extremely broad range of applications, including hardcoats, polysilicon, and LCD cell gaps to name just a
few.

Step 1: Select the film recipe
Select the film structure to bemeasured, in this case “SiO2 on Si”, from the Recipe: list box on themain
screen. If the structure to bemeasured does not exist, a new structuremust be defined. See Editing Film
Recipes for more details.



Step 2: Edit the film recipe
To edit the film stack, click the Edit Recipe... button to open the dialog box. Check to see that the film
stack matches that of the actual sample. If not, different films can be selected using either the drop down
menu next to thematerial or the Search function. This is also where you can enter a starting guess for
thickness as well as the desired constraint range.

Example Edit Recipe>Film Stack window

For this example, we'll use 10000 angstroms as theNominal thickness, with a constraint range of 100%.
Make sure that the SiO2 layer thickness is being solved for by clicking the checkbox underMeas. The
substrate should be set to Si. Underneath the Analysis Options tab, set the Analysis Method to Exact,
with nothing else enabled. Click OK to confirm the changes to the recipe.

Step 3: Take a Baseline Measurement
Take a baselinemeasurement by first clicking on the Baseline button on themain screen. A dialog box
will appear to step you through the process. Follow the steps on screen, and be sure to match the
material selected with the reflectance standard that will be used. For this example use the reference
square on the TS-Focus-SiO2-4-10000 as your Si reflectance standard.



Step 4: Make the Measurement
Make themeasurement by placing your sample on the stage and click on theMeasure button. If you're
finding it difficult to focus the system, see Focusing a Microscope Image on a Perfectly Flat Surface for
help.

FILMeasure will then acquire the reflectance spectrum and calculate the corresponding thickness. If the
measurement was successful, theminima and themaxima of the calculated reflectance (the red line on
the graph) will coincide in wavelength with theminima and themaxima of themeasured reflectance (the
blue line on the graph). In most cases they will not overlap, but will be separated in amplitude.

Measured and calculated reflectance spectra when measuring the thickness of SiO2 on silicon.

If the calculated (red) and measured (blue)minima and maxima do not coincide, then themeasurement
was not successful. There are several possible causes of an unsuccessful measurement. Themost
common for this type ofmeasurement are described in Cases #1, #2, and #3 in the Troubleshooting
section.

Example #2: Measuring Multi-Layer Films
This example demonstrates themeasurement multi-layer films using the VIS-AR reflectance standard.
This type ofmeasurement has a broad range of other applications, most commonly optical coating and
flat-panel display process films.



Step 1: Select the film recipe
Select the film structure to bemeasured, in this case “VIS-AR Thickness Standard”, from the Recipe: list
box on themain screen. If the structure to bemeasured does not exist, a new structuremust be defined
see Editing Film Recipes for more details.

Example Edit recipe>Film Stack window for measuring the VIS-AR Reflectance Standard.

Step 2: Edit the film recipe
To edit the film stack, click the Edit Recipe... button to open the dialog box. Check to see that the film
stack matches that of the actual sample. If not, different films can be selected using either the drop-down
menu next to thematerial or the Search function. If there are fewer layers present in the recipe than
there are in the film stack, additional layers can be added with the + buttons on the left hand side. The X
buttons can be used to remove additional layers if there are too many present. This is also where you
can enter a starting guess for thickness as well as the desired constraint range.

For this example, we'll use 83 nm as theNominal thickness for the first layer, 100 nm for the second, 30
nm for the third and 20 nm for the forth. When solving for multiple layers, it is suggested to use smaller
constraints ,35% in this case, to help improve solver speed and accuracy. Make sure that the layer
thicknesses are being solved for by clicking the checkboxes underMeas. The substrate should be set to



BK7. Underneath the Analysis Options tab, set the Analysis Method to Exact, with nothing else
enabled. Click OK to confirm the changes to the recipe.

Step 3: Take a Baseline Measurement
Take a baselinemeasurement by first clicking on the Baseline button on themain screen. A dialog box
will appear to step you through the process. Follow the steps on screen, and be sure to match the
material selected with the reflectance standard that will be used. For this example use the BK7 reflectance
standard. If you're having trouble focusing, and your microscope has a field stop, you can use this guide
to help focus your system. Otherwise, the edge of the BK7 or any surface scratches can be used to help
focus the system.

Step 4: Make the Measurement
Make themeasurement by placing your sample on the stage and click on theMeasure button.
FILMeasure will then acquire the reflectance spectrum and calculate the corresponding thickness. If the
measurement was successful, theminima and themaxima of the calculated reflectance (the red line on
the graph) will coincide in wavelength with theminima and themaxima of themeasured reflectance (the
blue line on the graph). In most cases they will not overlap, but will be separated in amplitude.

Measured and calculated reflectance spectra when measuring the thickness of the VIS-AR Reflectance Standard.

If the calculated (red) and measured (blue)minima and maxima do not coincide, then themeasurement
was not successful. There are several possible causes of an unsuccessful measurement. Themost
common for this type ofmeasurement are described in Cases #1 and #2 in the Troubleshooting section.



Example 3: Measuring Films on Transparent Substrates
In this example wewill demonstrate themeasurement of hardcoat on acrylic using the TS-Hardcoat-
Trans thickness standard. This type ofmeasurement does apply to an extremely broad range of
applications, including packaging films

Hardware:
For this type ofmeasurement the samplemust be flat, with the front and backsides parallel.

Step 1: Select the film recipe
Select the film structure to bemeasured, in this case “HC Standard on Acrylic - Trans”, from the Recipe:
list box on themain screen. If the structure to bemeasured does not exist, a new structuremust be
defined. See Editing Film Recipes for more information.

Step 2: Edit the film recipe

Example Edit Recipe>Film Stackwindow for measuring the thickness of a film on a transparent substrate



To edit the film stack, click the Edit Recipe... button to open the dialog box. Check to see that the film
stack matches that of the actual sample. If not, different films can be selected using either the drop-down
menu next to thematerial or the Search function. This is also where you can enter a starting guess for
thickness as well as the desired constraint range.

For this example, we'll assume themeasurements are being taken on a SS-3 stage. Set theNominal
thickness at 6microns, with a constraint range of 75%. Make sure that the HC Standard - 2 layer
thickness is being solved for by clicking the checkbox underMeas.

The second layer should be Acrylic - 2 with a thickness of 2000 μm, or 2mm, with Air as the substrate. Do
not enable solving for the Acrylic - 2 layer. This lets the software know that there is a finitely thick layer of
acrylic, so that it will accurately account for back reflections. If you're using the contact probe or contact
stage to takemeasurements, you can simply set the substrate Acrylic - 2 and enable account for backside
reflections under the Analysis Options tab. Click OK to confirm the changes to the recipe.

Step 3: Take a Baseline Measurement
Take a baselinemeasurement by first clicking on the Baseline button on themain screen. A dialog box
will appear to step you through the process. Follow the steps on screen, and be sure to match the
material selected with the reflectance standard that will be used. For this example use the BK7 reflectance
standard.

Step 4: Make the Measurement
Make themeasurement by placing your sample on the stage (or the contact probe on your sample) and
click on theMeasure button. FILMeasure will then acquire the reflectance spectrum and calculate the
corresponding thickness. If themeasurement was successful, theminima and themaxima of the
calculated reflectance (the red line on the graph) will coincide in wavelength with theminima and the
maxima of themeasured reflectance (the blue line on the graph). In most cases they will not overlap, but
will be separated in amplitude.



Measured and calculated reflectance spectra when measuring the TS-Hardcoat-Trans.

If the calculated (red) and measured (blue)minima and maxima do not coincide, then themeasurement
was not successful. There are several possible causes of an unsuccessful measurement. Themost
common for this type ofmeasurement are described in Cases #1, #2, and #3, in the Troubleshooting
section.

Measuring Thickness and Refractive Index
The following example describes themost common setup for index and thickness measurement.

Example 1: Measuring Thickness and Optical Constants of a Film.

Example 1: Measuring Thickness and Optical Constants of a Film
For this example wewill demonstrate themeasurement of Si3N4 on silicon but this type ofmeasurement
has an extremely broad range of applications, including themeasurement of oxides, polysilicon, and
optical coatings.

Hardware:
Any standard or rotating sample stage should work fine. The sample frontsidemust be flat. If the sample
backside is not flat or parallel with the frontside, then the contact stagemust be used.

Step 1: Select the film recipe
Select the film structure to bemeasured, in this case “Si3N4 on Si”, from the Recipe: list box on themain
screen. If the structure to bemeasured does not exist, a new structuremust be defined. See Editing Film
Recipes for more details.



Step 2: Edit the film recipe
To edit the film stack, click the Edit Recipe... button to open the dialog box. Check to see that the film
stack matches that of the actual sample. If not, different films can be selected using either the drop-down
menu next to thematerial or the Search function. This is also where you can enter a starting guess for
thickness as well as the desired constraint range.

Example Edit Recipe>Film Stackwindow for measuring the thickness, n, and k of films on an opaque substrate.

For this example, we'll use 300 nanometers as theNominal thickness, with a constraint range of 25%.
None should be selected underneath the Refine via drop-down list. Make sure that the Si3N4 layer
thickness is being solved for by left clicking the checkbox underMeas.

We'll also have to enable optical constants solving under the Composition options. These options
should be visible by default, but if they are not they can be accessed by clicking on the [+] underneath
Composition in the Film Stack tab. Left click on theMeas. button to enable optical constants solving,
and set the constraints for both n and k at 5. We'll also want to confirm that the correct model is
selected. Right click on theMeas. button to access the nk model drop-down list, and select the Si3N4
model. For more information on optical models, see nk Model.

The substrate should be set to Si. Underneath the Analysis Options tab, set the Analysis Method to
Exact, with nothing else enabled. Click OK to confirm the changes to the recipe.



Step 3: Take a Baseline Measurement
Take a baselinemeasurement by first clicking on the Baseline button on themain screen. A dialog box
will appear to step you through the process. Follow the steps on screen, and be sure to match the
material selected with the reflectance standard that will be used. For this example use the Si reflectance
standard.

Step 4: Make the Measurement
Make themeasurement by placing your sample on the stage and click on theMeasure button.
FILMeasure will then acquire the reflectance spectrum and calculate the corresponding thickness and
optical constants. If themeasurement was successful, the calculated reflectance (the red line on the
graph) will coincide with themeasured reflectance (the blue line on the graph).

If themeasured and calculated spectra do not fall on top of each other, the resulting thickness, n, and k
values are incorrect. If themismatch between measured data and calculation is only slight, the results
reported will only be off by a small amount. If themeasured and calculated spectra match, but the
results are implausible theremay be a problem with the sample positioning and light collection. Causes
and corrective actions to improve themeasurements are listed in Cases #4 and #5 in the
Troubleshooting section.

Measured and calculated reflectance spectra when measuring the thickness, n, and k of Si3N4 on silicon

Measurement Assumptions
The following assumptions must be valid if accuratemeasurements are to bemadewith the F20:



1. Every film present in the structure is specified in the Edit Recipe dialog box. This includes every film
present in the sample including so-called adhesion films, oxide films (unless they are less than 20 Å or
greater than 500microns thick), and films on the bottom surface of the substrate if the substrate is
transparent.

2. If the film is nonuniform, it has been accounted for in the recipe.

3. The light source has been allowed to warm up for at least 5minutes if measuring thickness of films
greater than 250nm, or 15minutes if measuring thickness of films less than 250nm, refractive index, or
reflectance.

In addition, the following assumptions aremade if optical constants and/or very thin films (<500 Å) are to
bemeasured:

4. If any grading is present (i.e. the refractive index and extinction coefficient are constant as a function of
depth and constant over the entire spot being measured), it has been accounted for in the recipe.

5. When using the SS-3 or SS-4 stage, the top surface of the sample under test is at the same height as
the reflectance standard that was used to make the reference calibration measurement.

6. The sample is flat. (The vacuum port may help in this case when samples are warped.)

7. No changes to themeasurement system (such as fibers being moved) or light source have occurred
since the acquisition of themost recent baseline.

8. No significant changes in room temperature (> 5 degrees F) have occurred since acquisition of themost
recent baseline.

If any of the above assumptions are not true, it may still be possible to make a measurement, but
accuracy may be degraded.

Hints for Improved Accuracy

This section contains various tips to help improve accuracy in your measurements.

Roughness.

Restricting the wavelength range of the analyzed reflection spectra.

Measuring thickness when the approximate thickness is not well known.

Measuring photosensitive films.



Roughness
Slight amounts of surface or interface roughness that may be present can decrease theGOF value of a
measurement. Entering a value or solving for roughness can partially account for this roughness so that
a better GOFmay be achieved. Generally, roughness is only present when the sample surface looks hazy
at themeasurement spot. The fact that haze can be seen means that there is scattered light. (A perfectly
smooth surface will scatter no light, and thus themeasured spot will not be visible.) Usually roughness
less than 2.5 nm will not be visible, while roughness greater than about 25 nm will be extremely hazy.

FILMeasure assumes a Gaussian distribution of the surface height irregularities about themean and it
assumes that the roughness is small compared to the wavelength. FILMeasure reports the rms
roughness value.

Restricting the wavelength range of the analyzed reflectance
spectrum
Occasionally spectra from measured films are adversely affected by factors such as absorbing dyes,
birefringence, or nonuniformity – all of which are difficult to model properly. It is often still possible to
make accurate thickness measurements of these films by analyzing only unaffected portions of the
spectra. The portion of the spectrum that is used to calculate film properties is determined by in the
recipe underneath the Analysis Options tab.

You can also adjust the wavelength analysis range in themain FILMeasure window using the gray bar at
the bottom of the graph. Click and drag either end of the bar to a new position on the x-axis to adjust the
analysis range.



Example of a non-ideal film (spectrum with no oscillations at lower wavelengths) that requires reduced wavelength
range for accurate measurement.



Example of a reduced wavelength range for measuring thickness of non-ideal films.

Measuring thickness when the approximate thickness is not well
known
Unless otherwise specified, FILMeasure will determine a film’s thickness by finding the best answer within
about 1000 Å of the initial (user supplied) value. If the approximate thickness of the film is not known to
better than about 1000 Å, then theGridmethod or the Fourier Transformmethod of determining
approximate thickness may be applied. See Editing Film Structures for more details.

Measuring photosensitive films
For layers such as unexposed photoresist that cannot be exposed to short-wavelength light, a filter may
be inserted in the slot on the light source.

Troubleshooting
For error messages or hardware problems encountered with your Filmetrics instrument, please use the
chart below to best diagnose your problem. For help with modeling, see Troubleshooting - Thickness
Modeling.

Question 1: Are you able to start FILMeasure without an error message?

No: Continue to Question 2.
Yes: Continue to Question 1-1.

Question 1-1: What sort of problem are you seeing?

1: The lamp doesn't turn on or the fan isn't working properly. See theNon-Operating Box, Lamp, or Fan
Troubleshooting Guide.
2: I get an error message when I click on something. Continue to Question 1-1-2.
3: Measurement results are wrong or unstable, after they had been good. See theMeasurement Results
are Incorrect or Unstable Troubleshooting Guide.
4: Measurement and/or baseline takes longer than it used to. See the Slow Operation Troubleshooting
Guide.

Question 1-1-2: If you're still seeing an error after you've power cycled and installed new software, then select the description which
most closely describes your error.

1: The error occurs during the baseline. See the Error Message During Baseline Troubleshooting Guide.
2: Some other error. See the Error Messages -Miscellaneous Troubleshooting Guide.

Question 2: Are you able to launch FILMeasure but it shows an error?

Yes: Continue to Question 2-1.
No: Then you need to install the software that comewith your new system, or you can request new
software. See the Software Reinstallation Guide.

Question 2-1: Does the error message start with "No Filmetrics instruments detected...."?

Yes: See theNon-Operating Box, Lamp, or Fan Guide.
No: See the Error Messages - Miscellaneous Troubleshooting Guide.



Power Cycling
Over the years we've found that about a third of support issues can be resolved by simply power cycling
the Filmetrics system and computer. Follow the simple steps below to power cycle your instrument.
Further assistancemay be received by contacting us using themethods described in the Contact
Information section.

Step 1: Shut down FILMeasure (it's OK in the rare case that you can't).

Step 2: Unplug all electrical connectors from the back of your Filmetrics box.

Step 3: Restart your computer, giving it time to load all drivers.

Step 4: Reconnect the electrical connections to your Filmetrics box. (Make sure that the power cord is
getting power, and that any switch near the power connector is turned on.)

Step 5: Restart FILMeasure

Software Reinstallation Guide
Follow the steps below to reinstall FILMeasure. Further assistancemay be received by contacting us
using themethods described in the Contact Information section.Warning: Upgrading software
versions may result in slightly different (<1%)measurement results due to continual improvement of our
solving algorithms and material files.

Step 1: Shut down FILMeasure (it's OK in the rare case that you can't).

Step 2: Unplug all electrical connectors from the back of your Filmetrics system.

Step 3: Are you installing this software on a computer which already has FILMeasure installed?
Yes: Go to Step 4.
Yes: Jump to Step 6.

Step 4:Make a backup copy of your recipe and material files:
FILMeasure versions 1 thru 4: Backup the directory C:\Program Files\FILMeasure
FILMeasure versions 5 and up:
On Windows XP: Backup the directory C:\Documents and Settings\All
Users\Application Data\Filmetrics
Note: The application Data folder may be hidden by default.
On Windows 7/8/Vista: Backup the directory C:\Program Data\Filmetrics\
Note: The Program Data folder may be hidden by default.

Step 5: Uninstall the current version of software:



On windows XP: Click Start > Control Panel > Add or Remove Programs > FILMeasure > Uninstall
On Windows 7/Vista: Click the Start orb > Control Panel > Programs and Features > FILMeasure >
Uninstall
On Windows 8: Control Panel >More settings > Programs and Features > FILMeasure > Uninstall

Step 6: Run the software installer and follow installer instructions.
Note: you will need administrative privileges to install the software.

Step 7: Reconnect your Filmetrics system.
Note for Windows XP: The "NewHardware Found" wizard may appear if your instrument has a
USB connection. Youmust click "Next and complete the driver installation process. This dialog box
may appear multiple times depending on the system configuration.
Note for Windows 7/8/Vista: An Information balloon may appear over the taskbar while drivers
are being installed. Please wait until the balloon indicates the drivers have been installed before
starting FILMeasure.

Step 8: Run the software to verify the installation was successful.

Non-Operating Box, Lamp, Or Fan
Follow the steps below to troubleshoot symptoms of a non-operating spectrometer, light source, or fan.
These are usually caused by having too much or not enough light. Further assistancemay be received by
contacting us using themethods described in the Contact Information section.

Step 1: Does the green LED on the right side of the front panel illuminate?
Yes: Jump to Step 3.
No: Go to Step 2.

Step 2: Is the power cord fully inserted into the back of the unit and a powered wall outlet? If your unit
has a rear power switch, is it on?

Yes: Go to Step 3
No: Plug into a powered outlet or switch on the unit

Step 3: Does the LED light on the light source switch illuminate when switched on?
Yes: go to Step 4
No: Possible faulty switch or faulty indicator lamp, contact Filmetrics.

Step 4: Is the cooling fan spinning? Determine this by listening to the cooling fan which is located
directly below the light source. (You'll need to get close to hear the fans on systems built after 2010.) For
F50 systems the chassis cooling fan is louder than the light source cooling fan. You'll need to get close to
the light source to hear the light source cooling fan.

Yes: Go to Step 5.
No: The cooling fan needs replacement, contact Filmetrics. Note: a bad cooling fan can draw
enough power to prevent the light source and box from operating properly.



Step 5: Does the light source illuminate?
Yes: Go to Step 6
No: The lamp has burned out. Please replace the lamp following the instructions here. A spare lamp
is included with most systems and additional lamps may be purchased on our website
www.filmetrics.comNote: users can confirm a halogen bad lamp by removing it and checking it
for electrical continuity.

Step 6: The following steps are to troubleshoot a box that is not being detected by the FILMetrics
software. This could be a software driver or (rarely) a hardware problem. To see what hardware your
computer is detecting, look in the windows devicemanager. (instructions on how to access the Device
Manager are included at the end of this document.)

In the DeviceManager, which device do you see?

"Filmetrics Measurement Instrument" or similar: In this case the system should be operation
correctly. If not, please contact Filmetrics.
"Unknown Device" or similar: The hardware appears to be operating properly, but the drivers for
the hardware are not installed. If you have already power cycled and installed themost current
Filmetrics software, please contact Filmetrics for further assistance.
Neither of the above: The hardware is not working properly. Go to Step 7

Step 7: Try a newUSB cable and plug it into a different USB port. Does this fix the problem?
Yes: Either the USB cable or port was bad.
No: The USB controller inside the FILMetrics boxmay be bad. Please contact Filmetrics.

Accessing Device Manager in Windows 7:
1. Click on the Start Orb.
2. In the Star Search box type: devicemanager. Press enter.
3. Select Devicemanager from the list.
4. You should see a Filmetrics Measurement Instrument tab. Expand the tab and the appropriate
driver should be listed for the Filmetrics instrument.

Accessing Device Manager in Windows XP:
1. Click Start.
2. Click on Control Panel
3. In the Control Panel double-click the Systems icon.
4. In the Systems Properties window click on the Hardware tab.
5. In the Hardware tab click the DeviceManager button.
6. You should see a Filmetrics Measurement Instrument tab. Expand the tab and the appropriate
driver should be listed for the Filmetrics instrument.

Error Message during Baseline
Follow the steps below to troubleshoot error messages encountered while taking a baseline. These are
usually caused by having too much or not enough light. Further assistancemay be received by
contacting us using themethods described in the Contact Information section.

http://filmetrics.com/accessories/replacement-lamps


Step 1:Which error message are you seeing while taking a baseline?
Received light signal is too bright: If you aremanually setting the integration time (see
Measurement Timing) then you need to reduce the integration time. Otherwise you can reduce the
light source intensity by using a flattening or neutral density filter. Optical filters can be purchased
on our website, www.filmetrics.com.
Baseline Failure. Reference and background spectra are almost the same: This error is often
caused by using the reference sample during the background step or vice versa, and is easily
corrected by taking retaking the baseline while providing the proper material for the proper step. If
this is not the case, go to Step 2.
Spectrometer peak intensity is x% of previous reference intensity: This error is often caused by
using the incorrect reference sample and is easily corrected. If this is not the case, jump to Step 5.

Step 2: Does the light source illuminate?
Yes: Go to Step 3.
No: Check theNon-Operating Box, Lamp, Or Fan Troubleshooting Guide.

Step 3: Check to see if there is a broken or misconnected fiber. With the light source on, confirm that
the illumination fiber is screwed into the light source securely, and that plenty of light is exiting the fiber
at the far end near where the sample is placed. The light can be seen by placing paper (e.g., business
card) near the sample location (do not look directly into the fiber if you are using a UV source). If plenty of
light is seen, next check the return fiber by removing it from the spectrometer input and connecting it to
the light source (removing the other fiber first of course). You should see light at the far end as before,
but it may be 3-4 times smaller and dimmer. Did you see light at the sample end using both fibers in the
light source?

Yes: The fiber appears to be good. Replace the fibers securely in their original positions (there will be
a white band on the light source fiber if the two ends are different) and go to Step 4.
No: The fiber optic may be broken. Replacements can be purchased on our website,
www.filmetrics.com

Step 4: Does your system havemultiple spectrometers (i.e. EXR or UVX)
Yes: Check the Acquisition Settings tab under Edit Recipe to make sure that your fiber optic
configuration matches the enabled spectrometers. Do this by making sure that each enabled
spectrometer has a fiber attached to it (or disable a spectrometer that is not being used).
No: If you are still experience problems, please contact us using the Contact Information section.

Step 5:Was the correct reference selected from the drop-down list?
Yes: Go to Step 6.
No: Re-baseline using the correct reference.

Step 6: Has the light source lamp recently been changed?
Yes: This error is an expected response, no further action required
No: Go to Step 7.

Step 7: Has the optical configuration been altered (i.e. switching from standard spot size to small spot
optics or a contact probe)?

http://filmetrics.com/accessories/optical-filters
http://filmetrics.com/accessories/fibers


Yes: This error is an expected response, no further action required
No: If you are still experiencing problems, please contact us using the Contact Information section.

Measurement Results are Incorrect or Unstable.
Follow the steps below to troubleshoot when measurement results are incorrect or unstable after the
results had been good for some time. Additional help troubleshooting general measurement issues may
be found in the Troubleshooting: Thickness Modeling section. Further assistancemay be received by
contacting us using themethods described in the Contact Information section.

Step 1: First confirm that you have selected the correct recipe for the sample that you aremeasuring
(i.e., the same recipe that previously was giving good measurements). Note that this troubleshooting
guide does not cover instances where recipe parameters have been changed.

Step 2: Confirm that the light source is turned on and that the fibers are securely tightened into the
light source and the spectrometer input. Confirm that the fiber is properly inserted into the stage (See
System Configurations if you are uncertain how to do this). Place a piece of paper at the sample
measurement location and confirm that you can see a light beam. Can the light beam be seen?

Yes: Jump to Step 4
No: Go to Step 3

Step 3: Is there light coming out of the light source? (If you are checking a UV light source, put on the
goggles that were supplied with the light source before checking.)

Yes: It appears the fiber may be broken. Replacements can be purchased on our website
www.filmetrics.com
No: Replace the lamp following the instructions here. A spare lamp is included with most systems
and additional lamps may be purchased on our websitewww.filmetrics.comNote: users can
confirm a halogen bad lamp by removing it and checking it for electrical continuity.

Step 4: Perform a new baseline, paying particular attention to making sure that you are using the
proper reference and that it is clean and right side up.

Step 5: Put a known-good sample on the stage and perform a measurement. If themeasurement is still
not correct, go to Step 6.

Step 6: Your lamp may be weak and needs to be replaced. The best way to tell is to replace it with the
instructions found here. A spare lamp is included with most systems and additional lamps may be
purchased on our websitewww.filmetrics.com.

Step 7: It may be that the stage optics have become unfocused. Please refer to the Focusing The Fiber
section.

If you are still experiencing problems with a slow baseline after the proceeding steps, please contact us
using themethods described in the Contact Information section.

http://filmetrics.com/accessories/fibers
http://filmetrics.com/accessories/replacement-lamps
http://filmetrics.com/accessories/replacement-lamps


Slow Operation Troubleshooting Guide
Follow the simple steps below to troubleshoot slow system operation. Further assistancemay be
received by contacting us using themethods described in the Contact Information section.

Step 1:When did you experience the slow operation?
During a baseline: Go to Step 2.
When I click Measure: Jump to Step 7.

Step 2: Slow baselines are generally caused by a low light level, which can have several causes. Does the
light source illuminate (be sure it is switched on, and that the shutter is open on UV systems)

Yes: Go to Step 3.
No: Check theNon-Operating Box, Light, or Fan Troubleshooting Guide

Step 3: Check to see if there is a broken or misconnected fiber. With the light source on, confirm that
the illumination fiber is screwed into the light source securely, and that plenty of light is exiting the fiber
at the far end near where the sample is placed. The light can be seen by placing paper (e.g., business
card) near the sample location (do not look directly into the fiber if you are using a UV source). If plenty of
light is seen, next check the return fiber by removing it from the spectrometer input and connecting it to
the light source (removing the other fiber first of course). You should see light at the far end as before,
but it may be 3-4 times smaller and dimmer. Did you see light at the sample end using both fibers in the
light source?

Yes: The fiber appears to be good. Replace the fibers securely into their original positions on the
spectrometer box and light source (there will be a white band on the light source fiber if the two
ends are different) and go to Step 4.
No: The fiber optic may be broken. Replacements can be purchased on our website,
www.filmetrics.com

Step 4: Does your system havemultiple spectrometers (i.e. EXR or UVX)
Yes: Check the Acquisition Settings tab under Edit Recipe to make sure that your fiber optic
configuration matches the enabled spectrometers. Do this by making sure that each enabled
spectrometer has a fiber attached to it (or disable a spectrometer that is not being used).
No: Go to Step 5.

Step 5: It may be that your lamp is old and needs to be replaced. The best way to tell is to replace it
with the instructions found here. A spare lamp is included with most systems and additional lamps may
be purchased on our websitewww.filmetrics.com.

Step 6: It may be that the stage optics have become unfocused. Please refer to the Focusing The Fiber
section.

If you are still experiencing problems with a slow baseline after the proceeding steps, please contact us
using themethods described in the Contact Information section.

http://filmetrics.com/accessories/fibers
http://filmetrics.com/accessories/replacement-lamps


Step 7: Unless the slow operation during measurement is a new problem, please confirm that your
computer meets theminimum system requirements as listed here. If it doesn't, please upgrade your
computer. Otherwise, go to Step 8.

Step 8: Ameasurement that takes a long time generally means that there is a large amount of
processing being required to find a solution and this is usually cause by a non-optimal recipe setting.
Please first confirm that you have selected the correct recipe for the film stack you aremeasuring.

Step 9:Open the recipe and make sure that you are not solving for too many parameters. Solving for
one or two thicknesses or a thickness and index should only take a second or two, but in some
circumstances the solving time can be increased 5-10x for each additional parameter. Solving for
nonuniformity (or adding it to increase accuracy of other parameters) can be especially time consuming.

Step 10: If you are solving for more than one thick layer (i.e., >10 um), you can speed up the solving
process by reducing the thickness constraint range (which can be safely reduced even more by using an
accurate nominal thickness guess) or by switching from using theGrid solver to the FFT solver in the
recipe.

If you are still experiencing problems with a slowmeasurement after the proceeding steps, please
contact us using themethods described in the Contact Information section.

Error Messages - Miscellaneous Troubleshooting Guide
This guide provides extended information on error messages a user may encounter on rare occasion
while using our software. Further assistancemay be received by contacting us using themethods
described in the Contact Information section.

Error during spectrum analysis/ unable to analyze spectrum.
This error is generally caused by a problem with the recipe constraints. Try adjusting the solver
wavelength range, thickness constraint range, or starting thickness value. Also make certain that the
starting thickness values have been entered using the correct units ofmeasure specified for the recipe.

Spectrum saturated.
This error indicates that the samplemeasured is more reflective than the spectrometer was expecting.
Reflectance data may not be accurate as a result. Take a new baseline to fix this problem.

Troubleshooting Thickness Modeling
In all cases it has been assumed that the user has read theMeasurement Assumptions section, and that
each criterion has been met.

Case #1: No oscillations, or portions of oscillations, are present in the measured reflectance
spectrum.

Case #2: The measured reflectance spectrum has periodic oscillations across the entire screen, but its
minima and maxima do not match up with the calculated reflectance.



Case #3: Two or more different, but nearly the same, thickness readings are obtainable from the
same measurement location.

Case #4: Poor matches between the measured and calculated reflectance spectra when measuring
thickness and optical constants.

Case #5: Several different answers, or one unreasonable answer, are found when measuring
thickness and optical constants, even though a good match is found between the measured and
calculated reflectance spectra.

Case 1: No oscillations, or portions of oscillations, are present in the measured
reflectance spectrum.
There can be several possible causes.

1. The film may just be very thin (<200 Å), thus presenting no discernible oscillations or only one
identifiable minima or maxima. The FFT solver will not be able to accurately analyze films without at least
one discernible full oscillation, in general meaning a film less than 0.2microns thick. Use one of the
Spectrum Matching solver methods (Robust, Exact) to analyze very thin films.

2. If the film is very rough, non-uniform in thickness over themeasurement area, or has a graded
interface it may not support coherent optical interference and thus it may not be able to bemeasured.
Try moving to a different measurement spot for a better signal.

3. An improper baselinemeasurement was taken, for example a thickness standard is presented as a
reflectance standard. Re-baseline the system while taking care to select the proper reflectance standard
and reference file.

Case 2: The measured reflectance spectrum has periodic oscillations across the
entire screen, but its minima and maxima do not match up with the calculated
reflectance.
Themost common cause is that the initial thickness guess was considerably different than the actual film
thickness, and due to the constraints on possible thicknesses, FILMeasure was unable to find the correct
answer.

To better understand this, it helps to know that the number of oscillations on the screen is proportional
to the film thickness. For example, if themeasured spectrum has roughly twice the number of the
oscillations that the calculated spectrum has, then themeasured film is roughly twice the thickness of
the calculated thickness. Using this information, the initial thickness guess and the thickness constraints
can be set more appropriately in the Edit Recipe dialog box. Another possible cause is found in Case #3
(incorrect dispersion).

Case 3: Two or more different, but nearly the same, thickness readings are
obtainable from the same measurement location.
When this occurs usually themeasured and calculated spectra match somewhat, but not very well
across the entire spectra (i.e., themeasured and calculated spectra match exactly only over a small



wavelength range and then gradually walk off one another outside this wavelength range). When
thickness is the only value being measured, this is normally caused by the refractive index of the
measured layer not matching that used by FILMeasure, especially when the film is greater than one
micron thick. Unless more accurate index values can be obtained, the best way to solve this problem is to
restrict the wavelength range used in the analysis.

Case 4: Poor matches between the measured and calculated reflectance spectra
when measuring thickness and optical constants.
There can bemany causes of this problem, including those listed in Case #1 and Case #2 above. Most
commonly when a poor fit between the spectra occurs, it is because:

1) The components of the film structure are not all included in the Edit Recipe>Film Stack dialog
box. Adjust the recipe accordingly and reanalyze the spectrum.

2) Very inaccurate initial guesses for the film thickness(es) have been listed. Try a new nominal
starting guess, or expand the thickness constraint range.

3) The optical constants listed in the Edit Recipe>Film Stack dialog box are far from the actual
optical constants in thematerial. Try selecting a different but similar material file if one is present,
for example switching from Acrylic to Acrylic - 2.

4) The film being measured has properties that are not taken into account by FILMeasure. Examples
of these properties are graded interfaces and non-uniform films. You can enable solving for these
conditions in the recipe.
Note: Enabling Nonuniformity solving will increase solving time.

Case 5: Several different answers, or one unreasonable answer, are found when
measuring thickness and optical constants, even though a good match is found
between the measured and calculated reflectance spectra.
This normally occurs when a large number of properties are being measured on a very thin film. In
general, the thinner a film is the less unique information that can be obtained from it. To understand
this, see Theory of Operation. To solve the problem, you can either:

A. Decrease the number of variables solved for.
B. Increase the amount of data provided to the solver (analyzing reflectance and transmittance at the
same time, or using themulti-spectral solver).
C. Enablemultiple Solver Cycles under the Edit Recipe>Analysis Options> Advanced dialog.



Advanced Features
This section describes how to create and edit material files within Windows Excel, as well as how to use
the Contact Probe Template Mode.

Creating and Editing n and k Files

Contact Probe Template Mode

Creating and Editing n and k Files
Creating new n and k files

New n and k files can be created by going to Edit>Material Library… Clicking theNew button will allow
the user to define a newmaterial file. Once clicked, while theDefault Model is selected, the user can
manually enter wavelength versus n or wavelength versus k values.

The user can also select Custom Model. While this is selected, clicking on theModel… button allows the
user to create n and k files using predefined mathematical models.

Once completed, clicking Save As…will save the new file as a custom material for later use.

Creating n and k files from a calculated spectrum

Files for n and k can be created directly from a calculated spectrum, where n and k aremeasured. Once a
spectrum is analyzed, go to File>Save Measured n and k… This will save your n and k files as a custom
material which can be loaded into the user recipe.

Editing n and k files

Existing material files can be edited by going to Edit>Material Library… There, the user can load a
material file by clicking Open. Values can then be changed manually. Clicking Savewill save over the
original file for later use. Use Save As to save the edited file under a new name.

Converting Microsoft Excel files into FILMeasure n and k files

For wavelength versus n or wavelength versus k data saved in Excel (*.xls) format, the data can be
directly saved as material files that can be read by FILMeasure.

For .nnn and .kkk files.

For both n and k files, the data should follow the format shown below, where the wavelength values, in
units of nanometers, are in the first column, and the n or k values are in the second. Note that the
version number (cell B1) refers to version of the file. For this cell, you can use 1. Thematerial number (cell
B2) refers to what material category the file corresponds to. Thematerial categories (and their
corresponding numbers) are: metal (1), semiconductor (2), insulator (3), photoresist (4), and other (5). By
putting the correct value for thematerial number, the file will automatically be sorted into the correct
category when selecting thematerial in the Edit Recipewindow.



To save the file created by Microsoft Excel, go to File>Save As… For Save as Type: choose CSV (Comma
delimited) (*.csv). For n files, save the file as “FILENAME.nnn”, and for k files, save the file as
“FILENAME.kkk” (FILENAME represents the name you wish to call the file; note that quotation marks
must be used to enclose the filename in Excel to force the extension to .nnn or .kkk). The file can then be
saved to the desktop, and Imported using the File>Import>Material File option

For .fitnk files.

The data should follow the format of shown below, where the wavelength values, in units of
nanometers, are in the first column, index of refraction (n) in the second, and extinction coefficient (k) in
the third.

The first few columns of the file should be identical to the figure below the only exception being cell B3
which should contain a number describing thematerial category. Thematerial categories (and their
corresponding numbers) are: metal (1), semiconductor (2), insulator (3), photoresist (4), and other (5).

To save the file created by Microsoft Excel, go to File>Save As… For Save as Type: choose CSV (Comma
delimited) (*.csv). Save the file as “FILENAME.fitnk” (FILENAME represents the name you wish to call the
file; note that quotation marks must be used to enclose the filename in Excel to force the extension to
.fitnk). The file can then be saved to the desktop, and Imported using the File>Import>Material File
option



Contact Probe Template Mode
This mode allows users to create and define template files for use with contact probemeasurements.
These templates can be used to ensure that measurements are taken from the same area of a given part.
To enable this function, you must first set theOptics Configuration to contact probe, and then enable
Contact Probe Template Mode underneath the Setup>Options>Data Recordingmenu.

With Contact Probe TemplateMode enabled, a new option is available in theMeasure tab on themain
FILMeasure screen. This menu allows you to makemeasurements to the selected template file, select a
new template file, or edit a template file. The following sections will demonstrate how to create and use a
template file.



Example Template Structure.

Creating a Template for Contact Probe Template Mode.

Using a Template File to Take Measurements.

Creating a New Template
Before creating a new template file, Contact Probe Template Modemust first be enabled. TheOptics
Configurationmust be set to Contact Probemode, and the checkbox next to Contact Probe Template
Mode underneath theOptions > Data Recordingmenu must be checked. Once Contact Probe Template
Mode is enabled, a new option will be available in themain FILMeasure window. Click Edit Template... to
open the Template Structure dialog box.



Within the Template Structure dialog box there are several options to build your template file.

Template Name:
This drop-down list allows you to select between saved templates.

Recipe Name:
Shows the recipe currently associated with a given template. This drop-down list may also be used to
select a new recipe.

Insert Background Image :
This allows the user to select an image of the sample to bemeasured as a background image over which
the template will be displayed. Images must be in the JPEG, Bitmap, or GIF format.

Delete Background Image :
For templates with a generic shape but no specific sample in mind (ie. a simple x,y grid), you can use this
option to remove a background image and set the template points against a gray field.

Add Points:
Allows the user to add points to the Template by left clicking anywhere on the image or field. These
points will automatically be numbered by the order they are added.

Remove:
Removes previously added points by clicking on them.

Move Points:
Click and drag points already included in the template to move them to a new location.

Clear Points:
Removes all points from the template at once.

Once you've finished editing the template file you can save the template file using one of the three
buttons at the bottom of the dialog box. The Save button will save the changes to the template selected
underneath the Template Name: box. The Save As button will prompt you to save the current template
under a new name. TheOK button will save the changes for immediate use, however any changes not
saved with either the Save or Save As button will be lost if another template is selected, or the software is
shut down.



With a new template defined, you can now use the file you've created to makemeasurements. SeeUsing
Contact Probe Template Mode for more information.

Using Contact Probe Template Mode
With a template already defined, you are now ready to use Contact Probe Template Mode to make
measurements. See Creating a New Template for details on creating templates.

Step 1:
Select the desired template from the drop down list in themain FILMeasure window. If the Template
Menu isn't available, see Setup > Options > Data Recording.

Step 2:
Click on theMeasure To Template button to open the Template file. If the button is grayed out, the
system will first require a Baseline.

Step 3:
A newwindowwill open showing the selected Template file. The software will be ready to acquire data, so
place the contact probe on the sample to measure the first spot. Lift the contact probe off the sample to
save the result. The currently active spot is indicated by a blinking dot. Repeat this process until all
measurements have been taken.
Note: If a measurement is taken incorrectly, it can be removed by clicking the undo button.



Step 4:
Save the output. By default the results will be placed in the history file. An image of the template with
thicknesses can also be saved with the Save To File button, or printed out using the Print button. A
working printer must be connected for the Print button to work. Clicking Acceptwill close the template
window.



Theory of Operation
This section describes how the instruments work and includes the theory themeasurements are based
on, specifics about the hardware, and more detail about the baselinemeasurement.

Measurement Theory

Thickness Measurement Details

Hardware Operation

The Baseline Measurement

Measurement Theory
Our instruments measure thin-film characteristics by either reflecting or transmitting light through the
sample, and then analyzing this light over a range of wavelengths. Because of its wave-like properties,
light reflected from the top and bottom interfaces of a thin film can be in-phase so that reflections add,
or out-of-phase so that reflections subtract. Whether the reflections are in- or out-of-phase (or
somewhere in between) depends on the wavelength of the light, as well as the thickness and properties
of the film (e.g., reflections are in-phase when λ = (2*n*d)/i, where λ is the wavelength, n is the refractive
index, d is the film thickness, and i is an integer). The result is characteristic intensity oscillations in the
reflectance spectrum (see Figure below). In general, the thicker the film, themore oscillations there are in
a given wavelength range.

Example of reflectance spectrum with oscillations.



The amplitude of the oscillations is determined by the refractive index and extinction coefficient of the
films and substrate. Therefore, by analyzing the period and amplitude of these oscillations, our
instruments can determine thickness ofmultiple thin films.

Thickness Measurement Details
Optical thin-film thickness measurements require the successful completion of two tasks: acquisition and
then analysis of an accurate reflectance spectrum. To determine film thickness, FILMeasure calculates a
reflectance spectrum that matches as closely as possible themeasured spectrum. FILMeasure begins
with an initial guess for what the reflectance spectrum should look like theoretically, based on the user’s
input of a film structure for the sample. Then FILMeasure varies the parameters it is solving for until the
calculated reflectance spectrum matches themeasured data. Mathematically, this procedure is
complicated by the fact that as the thickness of the films in the calculation is varied there can bemany
near matches. Therefore, an approach that simply homes in on a solution by finding successively better
approximations will not work unless the starting guess for optical thickness is within approximately 1000
Å if the actual thickness.

FILMeasure avoids homing in on a false solution by searching the entire acceptable thickness range to
determine the thickness that gives the best possible match between themeasured and calculated
spectra. The thickness range searched is determined by the initial guess for thickness together with the
thickness constraint. Since the time to find a solution is proportional to the range of thicknesses being
searched it is beneficial to provide an initial guess for the thickness of the films to bemeasured.

F20 Hardware Operation
The F20 performs two distinct functions: data acquisition and data analysis. Data analysis specifics are
discussed in Software Overview. In this section we describe how the F20 acquires accurate spectral
reflectance data.

Light is supplied by a tungsten-halogen bulb that generates light from approximately 375 nm to 3000 nm.
This light is delivered to and collected from the sample through a fiber-optic cable bundle and a lens. The
intensity of the reflected light is measured at different wavelengths with a spectrometer. The F20
spectrometer uses a diffraction grating to disperse the light and a linear photodiode array to measure
the light at the different wavelengths. After a user-selectable integration time, the accumulated charge in
each photodiode is read by the computer. Because a longer integration time results in a larger charge, it
is the integration time that determines the sensitivity of the spectrometer. Adjustment of the integration
time is used to obtain the proper signal level. Too short an integration time results in a weak, noisy
signal, while too long of an integration time results in a saturated signal. An optimized integration time is
set in the software during the baseline process.

The Baseline Measurement
The baselinemeasurement allows the FILMeasure software to take into account the response inherent
to the reflectancemeasurement hardware. It does this by measuring a reflectance standard and by
taking a “dark” reading. In any optical system there aremany components whose characteristics vary
with wavelength (e.g., the output of the light source and the sensitivity of the spectrometer). However,
when reflectancemeasurements aremade, only variations in reflectance vs. wavelength due to the



sample under test are of interest. Therefore, FILMeasuremust perform a calibration to determine the
spectral response of the system. This is done by making a measurement of a reflectance standard that
has known reflectance characteristics. Note that it is not necessary for the reflectance standard to be the
same as the substrate upon which films to bemeasured reside. The only purpose served by the
reflectance standard is to permit calibration of the optical system. For example, it is possible to use a Si
wafer as the reflectance standard and then measure films on GaAs, InP, glass, plastic, etc.

After the referencemeasurement is made a dark reading is taken. A non-zero dark level is due to current
leakage inherent to photodiodes, which causes each photodiode in the array to slowly charge up even
when no light enters the spectrometer. Thus, in order to make an accuratemeasurement of the light
entering the spectrometer, it is necessary to subtract this “dark” current contribution. This is the
purpose of the background reading, which measures themagnitude of the dark current for a given
integration time. When a “dark” measurement is made, a spectrum is measured that represents the
signal generated by the spectrometer when a sample of zero reflectance is measured. To simulate a
sample with zero reflectance during a “dark” measurement, a specularly reflecting sample can be held at
an angle with the light source turned on, or in many cases the light sourcemay simply be turned off
momentarily during the dark measurement.

Due to drift in the light source and temperature of the spectrometer electronics, it is a good idea to take
a baseline periodically.



How to Contact Us
Wewelcome suggestions from our users on ways to improve our software and hardware. Please send us
any suggestions you may have for improvements in the help file or new features you would like to see in
the software.

Wemay be reached by phone at +1-858-573-9300, by fax at +1-858-573-9400, by the Contact Us Now form
on our website, or by e-mail at support@filmetrics.com.

http://filmetrics.com/forms/generic
http://filmetrics.com/forms/generic
mailto:support@filmetrics.com?subject=Tech Support Request


Appendices
This section contains information on various topics as listed below:

Performance Specifications

How to Replace the Light Bulb

Automation and Data

Software License Agreement

Performance Specifications
F20-UV F20 F20-NIR F20-EXR F20-UVX F20-XT F20-XXT

Wavelength Range:
200-1100

nm
380-1050

nm
950-1700

nm
380-1700

nm
200-1700

nm
1440-

1690 nm
1580-1650

nm
Thickness Measurement

Range*:
1 nm-40
µm

15 nm-
100 µm

100 nm-
250 µm

15 nm-
250 µm

1 nm-250
µm

0.2 µm-
450 µm

10 µm-1
mm

Thickness Req'd to Measure n
and k*:

50 nm and
up

100 nm
and up

300 nm
and up

100 nm
and up

50 nm and
up

- -

Accuracy*:
The greater of 0.4% or 2 nm (1 nm for F20-UV, 5 nm for F20-XT and F20-

XXT)
Precision1: 0.1 nm 0.2 nm 0.1 nm 1 nm
Stability2: 0.07 nm 0.12 nm 0.07 nm 1 nm
Spot Size: Standard 1.5mm, Optional down to 20 µm 600 µm

Sample Size: From 1mm in diameter and up

Light Source:

Deuterium
& Tung-
sten-Hal-
ogen

Tungsten-Halogen

Deuterium
& Tung-
sten-Hal-
ogen

Tungsten-Halogen

* Material dependent.
1 1σ of 100 measurements of 500 nm SiO

2
-on-Si. Average of 1σ over 20 successive days.

2 2σ of daily average of 100 measurements of 500 nm SiO
2
-on-Si over 20 successive days.

Specifications subject-change without notice.

Computer Requirements:

Operating System:
PC: Windows XP (SP2) -Windows 8
Mac: OS X Lion/Mountain Lion running Parallels
Processor Clock Speed: 1.4 Ghz



Interface: USB 1.0 (USB 2.0 recommended)
Screen Resolution: 1024x768



System Configurations
Many accessories are available for the F20 series systems. Please refer to the following list to find
different applications for the configuration provided with your system. If you would like information on
purchasing additional accessories not included, please contact Filmetrics.

SS-3 Stage in Standard Spot position: The SS-3 stage is our standard stage for the F20 system. This is the
most versatile stage, which is shipped with each system unless otherwise specified.

SS-3 in UV position: The SS-3 stage in the UV position is optimized for use in UV applications.

SS-3 Stage in Small Spot position: The SS-3 stage in the small spot position is used to achieve a smaller
spot size for measurement. This is also useful for non-uniform or rough samples. The F20-XT system
comes standard with the SS-3 in the Small Spot position.

UV Extended Range (UVX): UVX systems provide themaximum possible range of thickness
measurements by including both UV and NIR detectors and light sources.

Contact Probe (CP-1): The contact probe is useful for measuring coatings on curved surfaces, such as
ophthalmic lenses. This accessory comes standard with the F20-HC, in place of the SS-3.

Contact Probe for Cylindrical Samples (CP-C): This contact probe is used for measuring coatings on
cylindrical samples.

Contact Stage Option (CS-1 Option): The contact stage option is used to measure the thickness of
freestanding films and coatings on glass samples where eliminating the backside reflection of the glass is
necessary. Use of the contact stage requires that the sample be flat.

Transmission Option (T1 Option): This option is used to make transmission measurements for
transparent samples.

Reduced Kinematic Mount with lens assembly (LA1-RKM): This assembly is used for inline applications,
or when a longer working distance in required.

Contact Probe (CP-1 and CP-C)
Connect the Contact Probe to the F20 as shown below. The two fiber ends leading from the Contact
Probe are identical; they can be attached to either the light source or spectrometer.



Contact Stage (SS-3 with CS-1 option):
Connect the contact stage fiber optic cable to the F20 as shown below. The two fiber ends leading from
the common end of the fiber are identical and can each be attached to either the light source or
spectrometer. Connect the four 3” legs to the bottom of the SS-3 Sample Stage. Remove the tilted mirror
insert in the SS-3 stage using the supplied 1/16” hex socket driver. Screw the fiber optic cable common
end into the black contact adapter, and then fully insert the contact adapter into the bottom hole in the
SS-3 stage, fastening it with the 1/16” hex driver



Reduced Kinematic Mount with Lens Assembly (LA1-RKM)
Step #1: Connect Fiber-Optic Cable to the F20
Connect the fiber-optic cable between the F20 front panel and the LA1-RKM as shown below. Slide the
fiber-optic cable part way into the lens assembly. The spring-loaded setscrew should be adjusted so that
the fiber-optic cable is held in place, yet it may bemoved in and out for focus adjustments.



Step #2: Adjust the lens assembly:
The focus and tilt of the lens assembly need to be adjusted for maximum signal and assumes that the
lens assembly has been mounted on a fixture approximately 6 inches above the sample surface, and the
“read” return fiber from the lens assembly to be adjusted is connected to the spectrometer input. The
idea here is to adjust the tilt and focus for maximum signal. To do this,

A. Turn on the light source with the front panel switch and start the FILMeasure program.

B. Go to the Set Up>Raw Signal… dialog box and set the integration time for 50milliseconds.

C. Click Start on the Set Up>Raw Signal… dialog box.

D. The fiber-optic cable contains 7 fibers – a single detection fiber surrounded by 6 illumination
fibers. Do a rough focus adjustment by placing a diffuse surface (a business card works well) at the
sample position and then focus the light beam on the sample position by sliding the fiber-optic
cable inside the lens tube. (The diffuse reflector will allow you to see the beam.)When 6 individual
spots can be seen, slide the fiber-optic cable farther into the LA1-RKM until the spots merge into the
center of the illuminated area.



E. Place a reflecting sample, such as a silicon wafer, on the sample stage, under the lens assembly.
You should now see a trace on the screen. Turn the tilt adjustment screws to maximize the signal. If
the signal saturates, reduce the integration time (see step b).

F. Optimize the focus to maximize themeasured signal by adjusting the fiber-optic cable position in
the lens assembly. Focus the light beam on the sample by sliding the fiber-optic cable inside the lens
tube. To see the beam, it may be necessary to place a diffuse surface, such as a business card, over
the sample. Ideally, the best focus adjustment is when the beam is just under focused. To achieve
this, focus the beam on the reflecting sample, and then move the fiber-optic cable slightly down in
the lens tube until maximum signal is obtained. When finished, tighten the socket head set screw
that secures the fiber. Once again, if saturation occurs, it may be necessary to reduce the
integration time.

G. Repeat steps e) and f) to make certain the adjustments are optimal.

H. The set up is now complete. Close the Set Up>Raw Signal… dialog box.

SS-3 in Small Spot Position
If the SS-3 stage is not already in Small Spot position, it can be repositioned by removing the hex-socket
bolt accessed on the backside of the stage arm. Next connect the fiber-optic cable between the F20 and
the stage as shown below. If the fiber does not have a white label indicating “Light Source”, then the two
fiber ends are identical and can each be attached to either the light source or spectrometer. Focusing will
be required beforemaking measurements, please see Focusing your fiber-optic.

SS-3 in Standard Position
Connect the fiber-optic cable to the F20 as shown below. Fully insert the fiber-optic cable into the lens
tube. Focusing may be required depending on the height of your sample, please see Focusing your
fiber-optic.

The fiber-optic cable contains 7 fibers – a single detection fiber surrounded by 6 illumination fibers. The
measurement spot size is not the illuminated area, but rather the intersection of the illuminated area



with the projected image of the detection fiber. When focused for maximum signal, themeasurement
spot size is roughly half the diameter of the illuminated area.

Transmission Option (SS-3 with T-1 option):
Connect the fiber-optic cable between the F20 and the stage as shown below. The fiber-optic cable
should be fully inserted into the arm on the stage. The screw on the end of the stage arm is actually a
spring-loaded ball plunger and does not require tightening. Connect the four 3” legs to the bottom of the
SS-3 Sample Stage. Remove the tilted mirror insert in the SS-3 stage using a 1/16” hex socket driver.
Screw one end of the single fiber optic cable into the black adapter and fully insert the adapter into the
bottom hole in the SS-3 stage, fastening it with the 1/16” hex driver. Before taking a baseline
measurement, be sure to set themode of operation to transmittance. See Example #4 for more
information on transmittancemeasurements.



SS-3 Stage in UV Position
If the SS-3 stage is not already in UV position, it can be repositioned by removing the hex-socket bolt
accessed on the backside of the stage arm. Next connect the fiber-optic cable between the F20, the UV
light source and the stage as shown below. If the fiber does not have a white label indicating “Light
Source”, then the two fiber ends are identical and can each be attached to either the light source or
spectrometer. Focusing will be required beforemaking measurements, please see Focusing your fiber-
optic.



SS-3 in UVX Configuration
Connect the fiber-optic cable by attaching the blue end labeled “UV Illumination” to the external UV light
source and the red end labeled “nir illumination” to the internal tungsten-halogen light source. Attach
the remaining two ends to the respective color coded spectrometer inputs: blue for UV, red for NIR.
Make sure that only the Deuterium bulb is turned on in the UV light source.

Insert the fiber-optic cable into the lens tube. Focusing the fiber may be required depending on the
height of your sample, please see Focusing your fiber-optic.

Light Bulb Replacement
NOTE: These instructions apply to VIS, NIR, and EXR systems only. Please see the seperate users manual for the Deuterium & Tungsten-
Halogen light source on UV and UVX systems.

* * Warning: * * Hazardous voltages are present within the unit. Never attempt
any maintenance without disconnecting the power cord.

Step by step:

1. Exit FILMeasure program and turn off your computer.

2. Disconnect power cable from the back of the unit.

3. Disconnect fiber optic cables from the front of the unit.

4. Remove the two captive screws on the back panel opening the two halves of the enclosure.



* * Warning: * * Caution, avoid touching any interior components, other than
the lamp, lamp base, and housing.
5. Pull the plunger behind the lamp all the way out.

6. Slide the lamp out of it holder, being careful not to touch the glass.

7. Unplug the old bulb from the lamp power connector.

8. Plug new lamp into the lamp power connector. Do not test lamp with lid removed.

9. Slide the new lamp into the holder, being careful not to touch the glass.

10. Gently release the plunger, holding the bulb in it's proper place. Do not test the bulb with the cover
removed.

11. Replace the cover and tighten the screws.



Software Automation
Measurements can be automated and additional data analysis can be performed by user-supplied
software. Themechanism by which this occurs is the FIRemote class which is part of FILMeasure.exe.
FIRemote is exposed as a public assembly and is accessible using theMicrosoft .NET programming
environment. The best way to learn how to use the FIRemote class is to look at the example program
and source code which are automatically installed as part of the FILMeasure software. Assuming that the
FILMeasure program is installed in the default location, the example software can be found in
C:\Program Files\Filmetrics\FILMeasure\SourceCode\FIRemoteTest. Additionally, an executable,
FIRemoteTest.exe, is located in the FILMeasure folder. All of the available commands can be tested using
FIRemoteTest.exe.

In order to set up a development environment for running and debugging code, the file system must be
set up so that the FILMeasure.exe is located in the same folder as the client program that is being
developed. Since FILMeasure expects to find its dependent files in the same directory as the executable,
this means that the entire contents of the FILMeasure folder must be copied to the build output folder.
For example, if the software development environment output folder is located in
C:\SourceCode\TestSln\TestPrj\bin\Debug\, then all the files and subfolders from C:\Program
Files\Filmetrics\FILMeasure\ must be copied to C:\SourceCode\TestSln\TestPrj\bin\Debug\.

Some of themethods listed in the following reference a SystemGuid. In the terminology used in this
document, a Measurement System is an object comprising one or moremeasurement channels, but
with operations that can be performed simultaneously on all the channels in the system. The
SystemGuid is used to distinguish between multiple simultaneously connected measurement systems.
Examples ofmeasurement systems with multiple measurement channels include the F32 and F37.
Documentation for methods applying only to such measurement systems can be found in the Less
Commonly Used Methods section. In addition, somemethods will accept either a SystemGuid or a
ChannelGuid. Such methods thus will execute an operation either on a single channel, or simultaneously
on all channels of a system.

Note that the FIMeasResults object which is returned by theMeasure and AnalyzeSpectrum methods
has a large number ofmember functions and properties. Since the names are all self-explanatory, we
have not attempted to list all of themembers here. The reader should use the Object Browser which is
built into Microsoft Visual Studio in order to discover the available properties and methods.

Methods, Property and Events:

New
AcquireSpectrum
ActivateChannelDisplayTab
AnalyzeSpectrum
AuthenticateRefBac
BaselineAcquireBackgroundAfterRef
BaselineAcquireReference
BaselineAcquireReferenceT
BaselineAcquireReferenceUsingOldSampleReflectance
BaselineAcquireSpectrumFromSample



BaselineCommit
BaselineSetRefMat
BaselineShowDialog
GUIVisible
HistoryDeleteAllResults
MeasChannelGuid
MeasChannelGuids
MeasChannelHWName
MeasChannelHWSerialNumber
MeasChannelName
Measure
NumberOfChannels
NumberOfSpectrometers
NumberOfSubSystems
OpticsConfiguration
OpenSpectrum
OpenSpectrumFromBuffer
RecipeInfo
SaveSpectrum
SaveSpectrumToBuffer
SetAnalysisWavelengthRange
SetMaterial
SetN
SetRecipe
SetRoughness
SetThickness
SpectrometerDiagnostics

Less-Commonly-Used Methods

The following methods are only rarely used. Methods which refer to a System are used with the F32 and
F37 thin film monitoring systems. Many methods accept either a measSystem or a measChannel guid.
However, somemethods are relevant only to a single channel. If you supply a measSystem guid as the
argument for one of thesemethods, an exception will be thrown.

ActivateMonitorDisplayTab
BaselineExistsAndIsAuthenticated
GeneralPurposeIOIsSupported
GeneralPurposeIOReadValue
GeneralPurposeIOSetValue
MeasSystemGuid
MeasSystemGuids
MeasSystemHWName
MeasSystemName
NumberOfSystems
SetRecipeModeToSpectrumAnalysis
SetRecipeSpectrumAnalysis
ShutdownRequestedHandler



SystemAutoSave
SystemAutoSaveBaseFileNameAndPath
SystemMeasure
SystemStartMonitoring
SystemStopMonitoring
SystemMeasurementCompletedEventHandler

New

Public Sub New(ByVal showFILMeasureGUI As Boolean) (deprecated)
Public Sub New(ByVal showFILMeasureGUI As Boolean, ByRef
theConstructorWarning As ConstructorWarning, ByRef warningMessage As
String)(deprecated)

Public Sub New(ByVal guiType AsGraphicalUserInterfaceType, ByVal
guiStartupState AsGraphicalUserInterfaceStartupState, ByVal
guiWindowStartupState AsFormWindowState, ByRef theConstructorWarning
AsConstructorWarning, ByRef warningMessage As String)

guiType – Determines if the FIRemote user interface and associated objects will be constructed at
startup. IfguiType is set to None, then the startup process is accelerated and memory usage is
minimized. However, the user interface cannot be displayed at a later time if it is not constructed during
the startup process. IfguiType is set to Standard, then the normal graphical user interface is
constructed during the startup process.

guiStartupState – Determines whether or not the FIRemote user interface is displayed at startup. Note
that this argument has no effect ifguiType = None. IfguiStartupState is set to Hidden, then
the user interface will not be visible on screen at the completion of the startup process. If the user
interface was constructed at startup, it can be displayed at a later time by setting GUIVisible =
True.

guiWindowStartupState – IfguiStartupState is set to Shown then the FIRemote User interface
windowwill appear on the screen at the completion of the startup process. Note that this argument has
no effect ifguiType = None. The state of the window is controlled by
guiWindowStartupState. You can set the state to Maximized, Normal, or Minimized.

theConstructorWarning – Returned value of type ConstructorWarning (None or
StartupRecipeLoadFailure).

warningMessage – Returned warning message string. Empty if None.

Remarks: You can suppress the display of the FIRemote user interface by setting guiType
appropriately. Typically, you would show the user interface during software development in order to aid
in the testing and debugging process. However, there are some applications where it is useful to be able
to show and hide the user interface while the software is running. This is accomplished with the



GUIVisible Property. The constructor warns if the startup recipe has problems loading and a default
recipe is loaded instead.

Return to Index...

AcquireSpectrum
Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Single,
ByRef spectrumData() As Single)
Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Single,
ByRef spectrumData() As Single, ByVal flushPipeline As Boolean)
Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Single,
ByRef spectrumData() As Single, ByRef secondarySpecWavelengths() As
Single, ByRef secondarySpecData() As Single, ByRef
primarySpecIsReflectance As Boolean)
Public Sub AcquireSpectrum(ByRef spectrumWavelengths() As Single,
ByRef spectrumData() As Single, ByVal secondarySpecWavelengths() As
Single, ByRef secondarySpecData() As Single, ByVal flushPipeline As
Boolean, ByRef primarySpecIsReflectance As Boolean)
Public Sub AcquireSpectrum(ByVal measChannelGuid As Guid, ByRef
spectrumWavelengths() As Single, ByRef spectrumData() As Single)
Public Sub AcquireSpectrum(ByVal measChannelGuid As Guid, ByRef
spectrumWavelengths() As Single, ByRef spectrumData() As Single,
ByVal flushPipeline As Boolean)
Public Sub AcquireSpectrum(ByVal measChannelGuid As Guid, ByRef
primarySpecIsReflectance As BooleanByRef spectrumWavelengths() As
Single, ByRef spectrumData() As Single)
Public Sub AcquireSpectrum(ByVal measChannelGuid As Guid, ByRef
spectrumWavelengths() As Single, ByRef spectrumData() As Single,
ByVal flushPipeline As Boolean, ByRef primarySpecIsReflectance As
Boolean)

measChannelGuid – The GUID of themeasurement channel for which a spectrum should be acquired. If
multiple measurement channels exist, themeasChannelGuid must be specified.

spectrumWavelengths – Array to contain wavelengths ofmeasured spectum data points.

spectrumData –Measured reflectance or transmittance data points.

secondarySpecWavelengths – For systems that can simultaneously acquire reflectance and
transmittance such as the F10-RT, array to contain wavelengths ofmeasured secondary spectum data
points. For all other systems, the returned argument is Nothing.

secondarySpecData – For systems that can simultaneously acquire reflectance and transmittance such
as the F10-RT, array to contain themeasured secondary spectum data points. For all other systems, the
returned argument is Nothing.



flushPipeline – If set to True (default), any data currently being acquired is ignored and new data is
acquired. If set to False, data currently being acquired is returned when acquisition is finished.

primarySpecIsReflectance – Indicates whether the primary spectrum data is Reflectance or
Transmittance.

Remarks: It is important that you catch exceptions which may occur as a result of calling this method.
See the example program for details.

Return to Index...

ActivateChannelDisplayTab
Public Sub ActivateChannelDisplayTab(ByVal measChannelGuid As Guid)

measChannelGuid – The GUID of themeasurement channel of the corresponding Measurement Tab to
be selected.

Remarks: After execution, the active tab in the FILMeasure GUI will be the specified Measurement Tab.
This method should only be executed if multiple measurement channels exist.

Return to Index...

AnalyzeSpectrum
Public Function AnalyzeSpectrum(ByVal formatSummaryAsRtf As Boolean)
As FIMeasResults
Public Function AnalyzeSpectrum(ByVal formatSummaryAsRtf As Boolean,
ByVal addToHistory As Boolean) As FIMeasResults
Public Function AnalyzeSpectrum(ByVal measChannelGuid As Guid, ByVal
formatSummaryAsRtf As Boolean) As FIMeasResults
Public Function AnalyzeSpectrum(ByVal measChannelGuid As Guid, ByVal
formatSummaryAsRtf As Boolean, ByVal addToHistory As Boolean) As
FIMeasResults

measChannelGuid – The GUID of themeasurement channel for which a spectrum should be analyzed
and optionally added to history. If multiple measurement channels exist, themeasChannelGuid must be
specified.

formatSummaryAsRtf – Themeasurement summary returned by the .ResultsSummary property of the
FIMeasResults object can be formatted as either plain text or as rtf. Formatting the summary as rtf is
advantageous if it will be displayed to the user because then the full set of information including bold
font and colors will be included.

addToHistory – Normally, each analysis result is added to the collection of results displayed in the History
area of FILMeasure. In some cases, it may be advantageous to suppress the addition of a result to the
History area. One example where this may be needed is the case where you wish to analyze a spectrum
with two different measurement recipes and then add only the best result to the History.



Remarks: Themost-recently acquired spectrum can be analyzed by calling this function.

Return to Index...

AuthenticateRefBac
Public Sub AuthenticateRefBac()
Public Sub AuthenticateRefBac(ByVal measChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a baseline should be
recovered. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: Calling this method is equivalent to clicking Baseline… to display the Baseline dialog and then
clicking Recover Last Baseline… to recover an old baseline spectrum. Note that there aremany situations
where an exception may be generated by calling this method. See the example program for details.

Return to Index...

BaselineAcquireBackgroundAfterRef
Public Sub BaselineAcquireBackgroundAfterRef()
Public Sub BaselineAcquireBackgroundAfterRef(ByVal
measChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a background should be
acquired. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: This method provides a means to automate what is most commonly called step #3 of the
Baseline procedure (step #4 for F10-VC, “Reflection Only” or “Reflection and Transmittance”. step #2 for
F10VC “Transmittance Only”). As the name of this method implies, you must have previously acquired a
reference spectrum.

Return to Index...

BaselineAcquireReference
Public Sub BaselineAcquireReference()
Public Sub BaselineAcquireReference(ByVal measChannelOrSystemGuid As
Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a reference should be
acquired. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: This method provides a means to automate what is most commonly called step #2 of the
Baseline procedure. Calling BaselineAcquireReferencemay generate an exception. There are a number of
rules required for successful execution of this method. Unless the acquisition timing mode in the recipe is
set to Manual, you must first callBaselineAcquireSpectrumFromSample. Alternatively, you could call the



variant of this method which accepts a user-supplied reflectance value if you know the sample reflectivity
and wish to skip step #1.

Return to Index...

BaselineAcquireReferenceT
Public Sub BaselineAcquireReferenceT()
Public Sub BaselineAcquireReferenceT(ByVal measChannelOrSystemGuid As
Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a Transmittance
reference should be acquired. If multiple measurement channels exist, themeasChannelGuid must be
specified.

Remarks: This method should only be called for the F10-VC. It provides a means to automate step #3 of
the Baseline procedure for “Reflectance Only” or “Reflectance and Transmittance” modes, or step #1 of
the Baseline procedure for “Transmittance Only” mode. No sample should be positioned on stage when
called.

Return to Index...

BaselineAcquireReferenceUsingOldSampleReflectance
Public Sub BaselineAcquireReferenceUsingOldSampleReflectance()
Public Sub BaselineAcquireReferenceUsingOldSampleReflectance(ByVal
measChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a reference should be
acquired. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: This method provides a means to automate steps 1 and 2 of the Baseline procedure by
assuming that the sample reflectance is unchanged from what it was the last time a baseline procedure
was performed. Note that an exception may be thrown in some situations including the case where no
prior baseline spectrum exists.

Return to Index...

BaselineAcquireSpectrumFromSample
Public Sub BaselineAcquireSpectrumFromSample()
Public Sub BaselineAcquireSpectrumFromSample(ByVal
measChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a sample spectrum
should be acquired. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: This method provides a means to automate what is most commonly called step #1 of the
Baseline procedure.



Return to Index...

BaselineCommit
Public Sub BaselineCommit()
Public Sub BaselineCommit(ByVal measChannelOrSystemGuid As Guid)

measChannelOrSystemGuid – The GUID of themeasurement channel for which a new baseline should be
commited. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: Call this method to finalize the baseline procedure and commit the acquired spectra for use as
a new baselinemeasurement.

Return to Index...

BaselineSetRefMat
Public Sub BaselineSetRefMat(ByVal theRefMat As String)
Public Sub BaselineSetRefMat(ByVal measChannelOrSystemGuid As Guid,
ByVal theRefMat As String)

measChannelOrSystemGuid – The GUID of themeasurement channel for which the referencematerial
should be assigned. If multiple measurement channels exist, themeasChannelGuid must be specified.

theRefMat – The referencematerial as it would normally appear in the list of referencematerials shown
in the Baseline dialog.

Remarks: This method should be called prior to acquiring a reference spectrum

Return to Index...

BaselineShowDialog
Public Sub BaselineShowDialog(ByRef dialogCanceled As Boolean)

dialogCanceled – True if user has canceled the dialog.

Remarks: Calling this method will cause the baseline dialog box to be displayed on the screen

Return to Index...

GUIVisible
Public Property GUIVisible As Boolean

Remarks: Setting this property to True will cause the FIRemote user interface to be displayed on the
screen. Note that this will normally cause the user interface window to appear on top of any other
windows. If you wish to keep another window on top of the FIRemote user interface window, it may be



necessary to call .BringToFront on that other window. If the FIRemote object is constructed with
guiType set to None then an exception will be thrown ifGUIVisible is set to True.

Return to Index...

HistoryDeleteAllResults
Public Sub HistoryDeleteAllResults()

Remarks: All measurement results in the History tab are deleted. If the FIRemote object has no user
interface (guiType = None in New()), then there is no measurement history and this function has
no effect.

Return to Index...

MeasChannelGuid
Public ReadOnly Property MeasChannelGuid(ByVal measChannelIndex As
Integer) As Guid
Public ReadOnly Property MeasChannelGuid(ByVal measSystemGuid As
Guid, ByVal measChannelIndex As Integer) As Guid

measSystemGuid – The GUID of a measurement system.

measChannelIndex – The zero-based index of themeasurement channel.

Remarks: Returns the GUID of the specified channel. Note this can be used to obtain the GUID used by all
methods requiring a measChannelGUID. Also note that the relationship between measChannelIndex and
MeasChannelGuid is not static. Future versions of FILMeasure will dynamically reorder this list in
response to an equipment connect/disconnect event. You should not rely on the order of the channels
in the list when attempting to perform a command on a certain channel.

Return to Index...

MeasChannelGuids
Public ReadOnly Property MeasChannelGuids() As Collection(Of Guid)

Remarks: Returns a collection of GUID for each measurement channel that exists.

Return to Index...

MeasChannelHWName
Public ReadOnly Property MeasChannelHWName(ByVal measChannelGuid As
Guid) As String

measChannelGuid – The GUID of themeasurement channel for which the channel hardware name
should be returned.



Remarks: The hardware name is composed of a system name string and a serial number string separated
by a colon. Example: F20:09A006.

Return to Index...

MeasChannelHWSerialNumber
Public ReadOnly Property MeasChannelHWSerialNumber(ByVal
measChannelGuid As Guid) As String
Public ReadOnly Property MeasChannelHWSerialNumber(ByVal
measChannelGuid As Guid, ByVal spectrometerIndex As Integer) As
String
Public ReadOnly Property MeasChannelHWSerialNumber(ByVal
measChannelGuid As Guid, ByVal subsystemIndex As Integer, ByVal
spectrometerIndex As Integer) As String

measChannelGuid – The GUID of themeasurement channel.

spectrometerIndex – The spectrometer index (to specify which ofmultiple spectrometers in the channel).

subsystemIndex – The subsystem index (to select among multiple subsystems in the channel).

Remarks: Returns the controller hardware serial number of the specified spectrometer. If the
spectrometer or subsystem are not specified, the default index = 0will be used. If there aremultiple
subsystems, a hyphen followed by the subsystem ID is appended to the hardware serial number.
Example for single subsystem: 09A006. Example for multiple subsystem: 09A007-1

Return to Index...

MeasChannelName
Public ReadOnly Property MeasChannelName(ByVal measChannelGuid As
Guid) As String

measChannelGuid – The GUID of themeasurement channel for which the channel name should be
returned.

Remarks: By default the channel name is the empty string.

Return to Index...

Measure
Public Function Measure(ByVal formatSummaryAsRtf As Booleanl) As
FIMeasResults
Public Function Measure(ByVal formatSummaryAsRtf As Booleanl, ByVal
addToHistory As Booleanl) As FIMeasResults
Public Function Measure(ByVal measChannelGuid As Guid, ByVal
formatSummaryAsRtf As Booleanl) As FIMeasResults



Public Function Measure(ByVal measChannelGuid As Guid, ByVal
formatSummaryAsRtf As Booleanl, ByVal addToHistory As Booleanl) As
FIMeasResults

measChannelGuid – The GUID of themeasurement channel for which a spectrum should be acquired
and analyzed. If multiple measurement channels exist, themeasChannelGuid must be specified.

formatSummaryAsRtf – Themeasurement summary returned by the .ResultsSummary property of the
FIMeasResults object can be formatted as either plain text or as rtf. Formatting the summary as rtf is
advantageous if it will be displayed to the user because then the full set of information including bold
font and colors will be included.

addToHistory – Normally, each analysis result is added to the collection of results displayed in the History
area of FILMeasure. In some cases, it may be advantageous to suppress the addition of a result to the
History area. One example where this may be needed is the case where you wish to analyze a spectrum
with two different measurement recipes and then add only the best result to the History.

Remarks: Calling this function is equivalent to clicking theMeasure button in FILMeasure. Note that if the
Measure button is disabled when you call this function, an exception will be thrown.

Return to Index...

NumberOfChannels
Public ReadOnly Property NumberOfChannels() As Integer

Remarks: Number ofmeasurement channels that exist.

Return to Index...

NumberOfSpectrometers
Public ReadOnly Property NumberOfSpectrometers(ByVal measChannelGuid
As Guid) As Integer
Public ReadOnly Property NumberOfSpectrometers(ByVal measChannelGuid
As Guid, ByVal subsystemIndex As Integer) As Integer

measChannelGuid – The GUID of themeasurement channel.

subsystemIndex – Thesubsystem index (to specify which ofmultiple subsystems in the channel).

Remarks: The number of spectrometers in the specified subsystem. If subsystemIndex is not provided,
the default index = 0will be used.

Return to Index...



NumberOfSubSystems
Public ReadOnly Property NumberOfSubSystems(ByVal measChannelGuid As
Guid) As Integer

measChannelGuid – The GUID of themeasurement channel.

Remarks: The number of subsystems that compose the specified measurement channel.

Return to Index...

OpticsConfiguration
Public Property OpticsConfiguration() As OpticsConfigSystemTypes
[Get/Set]
Public Property OpticsConfiguration(ByVal measChannelGuid As Guid) As
OpticsConfigSystemTypes [Get/Set]

measChannelGuid – The GUID of themeasurement channel for which the OpticsConfiguration is to be
get/set. If multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: If the OpticsConfigSystemTypes is not be compatible with the hardware an exception will be
thrown.

Return to Index...

OpenSpectrum
Public Sub OpenSpectrum(ByVal filenameAndPath As String)
Public Sub OpenSpectrum(ByVal filenameAndPath As String, ByVal
measChannelGuid As Guid)

filenameAndPath – The full path and filename (including extension) of the spectrum. If the file cannot be
opened, an exception will be thrown.

measChannelGuid – The GUID of themeasurement channel for a spectrum is to be opened. If multiple
measurement channels exist, themeasChannelGuid must be specified.

Remarks: Unlike the behavior when a spectrum is opened in FILMeasure, the software will not
automatically analyze the spectrum after opening it. If analysis of the spectrum is desired, then the
Analyze function must be called.

Return to Index...

OpenSpectrumFromBuffer
Public Sub OpenSpectrumFromBuffer(ByVal theBuffer As Byte())
Public Sub OpenSpectrumFromBuffer(ByVal theBuffer As Byte(), ByVal
measChannelGuid As Guid)



theBuffer – Byte array containing spectrum. Data in this array must have been created by
SaveSpectrumToBuffer method.

measChannelGuid – The GUID of themeasurement channel for a spectrum which is to be opened. If
multiple measurement channels exist, themeasChannelGuid must be specified.

Remarks: See remarks after SaveSpectrumToBuffer

Return to Index...

RecipeInfo
Public ReadOnly Property RecipeInfo() As FIRecipeInfo
Public ReadOnly Property RecipeInfo(measChannelOrSystemGuid) As Guid)
As FIRecipeInfo

measChannelGuid - The GUID of themeasurement channel associated with a measurement recipe. If
multiple measurement channels exist themeasChannelOrSystemGuid must be specified.

Remarks: The FIRecipeInfo object contains an assortment of information abou tthe recipe including
information about the film stack, if appropriate..

Return to Index...

SaveSpectrum
Public Sub SaveSpectrum(ByVal filenameAndPath As String)
Public Sub SaveSpectrum(ByVal filenameAndPath As String, ByVal
ifTextFormatWriteYDataAsPercent As Boolean)

filenameAndPath – The full path and filename (including extension) of the spectrum. The file format is
determined by the extension. Valid file extensions are the same as the extensions listed in the Save
Spectrum dialog windows accessed via the File->SaveMeasured Spectrum menu item in FILMeasure.

ifTextFormatWriteYDataAsPercent – If this version of SaveSpectrum without this parameter is called, the
result is the same as calling the version with this parameter and setting its value to True. Thus, the only
reason to call the second variant of the function is if the spectrum is being saved as a text format (either
.txt or .csv) and the value of this parameter is set to False

Return to Index.

SaveSpectrumToBuffer
Public Sub SaveSpectrumToBuffer( As Byte()

Remarks: This function allows the caller to rapidly retrieve the complete set of data contained in a
spectrum, thereby avoiding the time that would be consumed if the spectrum were saved to a file. This
may be useful in cases where the caller wishes to rapidly acquire a number of spectra and store them up



for later saving to file or analysis. The contents of the buffer should be considered opaque. Any changes
to the data in the buffer may render the data unusable and/or may not be compatible with future
versions of FILMeasure.

Return to Index.

SetAnalysisWavelengthRange
Public Sub SetRecipeSetAnalysisWavelengthRange(ByVal
measChannelGuidmeasChannelOrSystemGuid AsGuid, ByVal startWavelength_
nm As Single, ByVal endWavelength_nm As Single)
Public Sub SetAnalysisWavelengthRange(ByVal startWavelength_nm As
Single, ByVal endWavelength_nm As Single)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

startWavelength_nm – Starting wavelength for spectrum analysis.

endWavelength_nm – Ending wavelength for spectrum analysis.

Remarks: Setting the wavelength range will also switch the recipe into using a specified wavelength range
instead of using the entire wavelength range visible on the spectrum graph.

Return to Index.

SetMaterial
Public Sub SetMaterial(ByVal measChannelOrSystemGuid AsGuid, ByVal
layerNumber As Integer, ByVal materialName As String)
Public Sub SetMaterial(ByVal layerNumber As Integer, ByVal
materialName As String)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

layerNumber – The layer number for which to modify thematerial.

materialName – String containing name of thematerial.

Remarks: You can alter thematerial of a layer in the current recipe using themethod. An exception will be
thrown if the layer number is out-of-bounds or thematerial does not exist.

Return to Index.



SetN
Public Sub SetN(ByVal measChannelOrSystemGuid AsGuid, ByVal
layerNumber As Integer, ByVal refractiveIndex As Single)
Public Sub SetN(ByVal layerNumber As Integer, ByVal refractiveIndex
As Single)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

layerNumber – The layer number for which to set the refractive index.

refractiveIndex – New refractive index value for layer.

Remarks: You can alter thematerial of a layer in the current recipe using themethod. An exception will be
thrown if the layer number or refractive index are out-of-bounds.

Return to Index.

SetRecipe
Public Sub SetRecipe(ByVal measChannelOrSystemGuid As Guid, ByVal
recipeName As String)
Public Sub SetRecipe(ByVal recipeName As String)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

recipeName – The recipe name to be selected must exist in the list of recipes. Note that you can select
recipes contained in subfolders by specifying the relative path, using the backslash character ‘\’ to
separate folder names as is conventional in path naming.

Remarks: The current spectrum will not be automatically reanalyzed when a new recipe is selected. To
reanalyze the spectrum you must callAnalyzeSpectrum.

Return to Index.

SetRoughness
Public Sub SetRoughness(ByVal measChannelOrSystemGuid As Guid, ByVal
layerNumber As Integer, ByVal roughness_nm As Single)



Public Sub SetRoughness(ByVal layerNumber As Integer, ByVal
roughness_nm As Single)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

layerNumber – The layer number for which to modify the roughness.

roughness_nm – Roughness value which will appear in the Layers tab of the recipe for the specified layer.
Units are nanometers.

Remarks: You can alter the roughness of a layer in the current recipe using themethod. An exception will
be thrown if the layer number or roughness are out-of-bounds.

Return to Index

SetThickness
Public Sub SetThickness(ByVal measChannelOrSystemGuid As Guid, ByVal
layerNumber As Integer , ByVal thickness_nm As Single)
Public Sub SetThickness(ByVal layerNumber As Integer, ByVal
thickness_nm As Single)

measChannelOrSystemGuid – The GUID of themeasurement channel or system. If multiple
measurement channels exist, themeasChannelOrSystemGuid must be specified (since each
measurement channel has its own active recipe).

layerNumber – The layer number for which to modify the thickness.

thickness_nm – Thickness value which will appear in the Layers tab of the recipe for the specified layer.
Units are nanometers.

Remarks: You can alter the thickness of a layer in the current recipe using themethod. An exception will
be thrown if the layer number or roughness are out-of-bounds.

Return to Index

SpectrometerDiagnostics
Public ReadOnly Property SpectrometerDiagnostics()
AsFISpecDiagnosticsInfo()
Public ReadOnly Property SpectrometerDiagnostics(ByVal
measChannelGuid AsGuid)As FISpecDiagnosticsInfo()
Public ReadOnly Property SpectrometerDiagnostics(ByVal
measChannelGuid As Guid, ByVal subsystemIndex As Integer) As
FISpecDiagnosticsInfo()

measChannelGuid – The GUID of themeasurement channel.



subsystemIndex – The subsystem index (to select among multiple subsystems in the channel).

Remarks: Returns an array of objects containing information about the spectrometers. Information
includes integration time, peak raw signal intensities of reference and background spectra, etc.

Return to Index

ActivateMonitorDisplayTab
Public Sub ActivateMonitorDisplayTab()
Public Sub ActivateMonitorDisplayTab(ByVal measSystemGuid As Guid)

measSystemGuid – The GUID of themeasurement System. If multiple measurement channels exist, the
measChannelGuid must be specified (since each measurement channel has its own active recipe).

Remarks: This function is provided to permit synchronization of the FILMeasure user interface with the
user interface of a client program.

Return to Index...

BaselineExistsAndIsAuthenticated
Public Function BaselineExistsAndIsAuthenticated(ByRef
authenticationIsPossible As Boolean) As Boolean
Public Function
BaselineExistsAndIsAuthenticated(measChannelOrSystemGuid As Guid,
ByRef authenticationIsPossible As Boolean) As Boolean

authenticationIsPossible – If baseline is not authenticated, it is possible to authenticate it when
authenticationIsPossible = True.

Remarks: In some cases, it is desirable to check whether the baseline is already authenticated and if not
whether it is possible to authenticate it. The client software has the option of automatically
authenticating the baseline if that is desirable.

Return to Index...

GeneralPurposeIOIsSupported
Public ReadOnly Property GeneralPurposeIOIsSupported() As Boolean

Remarks: Primary purpose of this property is to permit the example program to hide or show the
General Purpose IO controls. This property will be True for equipment that has the General Purpose IO
 hardware.

Return to Index...



GeneralPurposeIOReadValue
Public Function GeneralPurposeIOReadValue() As Byte

Remarks: Returns a single byte containing the current values of the general purpose IO logic input
signals. Bit value of 1means that the input voltage is in the logic high state. These input signals are only
available on certain types of equipment.

Return to Index...

GeneralPurposeIOSetValue
Public Sub GeneralPurposeIOSetValue(newValue As Byte)

newValue - New values for the output bits.

Remarks: Sets the output state of the general purpose IO logic output signals. Setting a bit to 1will set
the corresponding output to the logic high state. These output signals are only available on certain types
of equipment.

Return to Index...

MeasSystemGuid
Public ReadOnly Property MeasSystemGuid(ByVal measSystemIndex As
Integer) As Guid

measSystemIndex – The zero-based index of the system.

Remarks: Returns the GUID of the specified system. Note this can be used to obtain the GUID used by all
methods requiring a measSystem GUID. Also note that the relationship between measSystemIndex and
MeasSystemGuid is not static. Future versions of FILMeasure will dynamically reorder this list in
response to an equipment connect/disconnect event. You should not rely on the order of the systems in
the list when attempting to perform a command on a certain system.

Return to Index...

MeasSystemGuids
Public ReadOnly Property MeasSystemGuids() As Collection(Of Guid)

Remarks: Returns a collection of GUIDs containing one item for each measurement system that exists.

Return to Index...

MeasSystemHWName
Public ReadOnly Property MeasSystemHWName(ByVal systemGuid As Guid)
As String



systemGuid – The GUID of a measurement system.

Remarks: The hardware name is composed of a system name string and a serial number string separated
by a colon. Example: F37:09A006

Return to Index...

MeasSystemName
Public ReadOnly Property MeasSystemName(ByVal systemGuid As Guid) As
String

systemGuid – The GUID of a measurement system.

Remarks: The default system name is the empty string.

Return to Index...

NumberOfSystems
Public ReadOnly Property NumberOfSystems() As Integer

Remarks: Number ofmeasurement systems that exist.

Return to Index...

SetRecipeModeToSpectrumAnalysis
Public Sub SetRecipeModeToSpectrumAnalysis()
Public Sub SetRecipeModeToSpectrumAnalysis(ByVal
measChannelOrSystemGuid As Guid)
Public Sub SetRecipeModeToThickness()
Public Sub SetRecipeModeToThickness(ByVal measChannelOrSystemGuid As
Guid)

measChannelOrSystemGuid – The GUID of one of themeasurement channels in a muliple channel
system or the GUID of the system. If multiple measurement channels exist, themeasChannelGuid must
be specified.

Remarks: If Spectrum Analysis recipes are supported by the hardware or add-on licenses, then the
Measure tab in the user interface will display a tab control that allows the user to switch modes. The tab
associated with the Spectrum Analysis recipemode is labeled “AR” or “Spectrum”. The other tab is
labeled “HC” or “Thickness” or “Thickness, n, k, r”. Calling SetRecipeModeToSpectrumAnalysis or
SetRecipeModeToThickness is the same as clicking on the Spectrum or Thickness tab in the user
interface.

SetRecipeSpectrumAnalysis
Public Sub SetRecipeSpectrumAnalysis(ByVal recipeName As String)



Public Sub SetRecipeSpectrumAnalysis(ByVal measChannelOrSystemGuid As
Guid, ByVal recipeName As String)

Public Sub SetRecipeThickness()
Public Sub SetRecipeThickness(ByVal measChannelOrSystemGuid As Guid,
ByVal recipeName As String)

measChannelOrSystemGuid – The GUID of one of themeasurement channels in a multiple channel
system or the GUID of the system. If multiple measurement channels exist, themeasChannelGuid must
be specified.

recipeName – The recipe name to be selected must exist in the list of recipes. Note that you can select
recipes contained in subfolders by specifying the relative path, using the backslash character ‘\’ to
separate folder names as is conventional in path naming.

Remarks: Same as SetRecipeModeToSpectrumAnalysis or SetRecipeModeToThickness, but caller
specifies name of recipe to load during recipemode switch.

ShutdownRequestedHandler
Public Delegate SubShutdownRequestedHandler(ByVal e As
Windows.Forms.FormClosingEventArgs)
Public Event ShutdownRequested As ShutdownRequestedHandler

e – The standard argument type for a form about to close.

Remarks: The client software can prohibit closing of the software by setting e.Cancel to True.
Alternatively, the client softwaremay wish to perform certain actions prior to allowing the FIRemote class
to shut down.

Return to Index...

SystemAutoSave
Public Property SystemAutoSave() As Boolean
Public Property SystemAutoSave(ByVal systemGuid As Guid) As Boolean

systemGuid – The GUID of a measurement system.

Remarks: You can set or get the state of the AutoSave setting using this property. Note that setting a
new state for SystemAutoSave will not affect an on-going monitor process, but will take effect the next
time a new set of data starts being collected.

Return to Index...

SystemAutoSaveBaseFileNameAndPath
Public Property SystemAutoSaveBaseFileNameAndPath() As String



Public Property SystemAutoSaveBaseFileNameAndPath(ByVal systemGuid As
Guid) As String

systemGuid – The GUID of a measurement system.

Remarks: You can set or get the base filename and path for the AutoSave file using this property. The full
filename is generated by appending a date and time stamp to the base filename. Note that setting a new
filenamewill not affect an on-going monitor process, but will take effect the next time a new set of data
starts being collected.

Return to Index...

SystemMeasure
Public Function SystemMeasure() As FIMeasResultValuesOnly
Public Function SystemMeasure(ByVal
deleteAccumulatedDataBeforeMeasure As Boolean) As
FIMeasResultValuesOnly
Public Function SystemMeasure(ByVal systemGuid As Guid) As
FIMeasResultValuesOnly
Public Function SystemMeasure(ByVal systemGuid As Guid, ByVal
deleteAccumulatedDataBeforeMeasure As Boolean) As
FIMeasResultValuesOnly

deleteAccumulatedDataBeforeMeasure – There is no analog for this parameter in the user interface.
Setting this parameter to True causes any existing accumulated data points to be deleted before the
measurement is performed.

systemGuid – The GUID of a measurement system.

Remarks: Acquire and measure on all channels in a system. Measurement is performed simultaneously
on all channels. Measured results are contained in an FIMeasResultValuesOnly object.

Return to Index...

SystemStartMonitoring
Public Sub SystemStartMonitoring()
Public Sub SystemStartMonitoring(ByVal systemGuid As Guid)

systemGuid – The GUID of a measurement system.

Remarks: This function starts a monitoring process

Return to Index...

SystemStopMonitoring
Public Sub SystemStopMonitoring()



Public Sub SystemStopMonitoring(ByVal systemGuid As Guid)

Remarks: This function stops a monitoring process.

Return to Index...

SystemMeasurementCompletedEventHandler
Public Delegate Sub SystemMeasurementCompletedEventHandler(ByVal
systemGuid As Guid, ByVal theResults As FIMeasResultValuesOnly)
Public Event SystemMeasurementCompleted As
SystemMeasurementCompletedEventHandler

systemGuid – The GUID of a measurement system.

Remarks: This event is raised upon completion of a SystemMeasure task and after each measurement
during a SystemMonitor process. You should avoid performing lengthy operations (such as writing data
to a file) in the handler for this event because themonitor process will be halted until the handler
function exits. If execution of a lengthy operation is needed, you should invoke a different thread to
perform the operation. If the event is raised as a result of completing a SystemMeasure task, then you
will need to exercise care to avoid creating a threading deadlock. A deadlock will occur if you invoke the
thread which called SystemMeasure in the handler for this event because that thread will not return
from SystemMeasure until all the event handlers have finished executing. See the FIRemoteTest example
program to see one way to avoid the deadlock problem.

Return to Index...

End User Software License
Important – Read carefully: This Agreement (“Agreement”) is a legal agreement between you (both you,
individually and your company entity) and Filmetrics, Inc. (“Licensor” or “Filmetrics”) The FILMeasure
software (the “Software”) subject to this Agreement and any accompanying documentation is for your
use solely and exclusively with a device manufactured by or for Filmetrics (“Filmetrics Device”).

By downloading, installing, copying or otherwise using the Software you
expressly agree to be bound by all of the terms of this Agreement. This Agreement is
displayed for you to read prior to using the Software. If you choose not to accept, or do not agree with all
of the provisions of this Agreement, do not download, install or use the Software but, instead delete it
and, if applicable, request from the authorized Filmetrics distributor from whom you purchased the
Software, a full refund of any fees you paid for the Software.

LICENSE

This license agreement (“license”) permits you to use one copy of the Software on any single computer.
The Software is owned by Filmetrics and is protected by United States copyright law and international
treaty provisions. Therefore, this software should be treated as any other copyrighted material except
that you may either: (1) make one copy of the Software for archival backup purposes, or (2) copy the
Software to a single hard disk in all cases, solely for use with a Filmetrics Device. If the Software is used on



a networked computer system wheremore than one computer can access the Software provisions must
bemade to insure that the number of concurrently executing copies of the Software cannot exceed the
number of licenses.

You may transfer the Software and all rights under this Agreement to another party together with a copy
of this Agreement if the other party agrees to accept the terms and conditions of this Agreement. If you
transfer the Software, you must at the same time either transfer all copies (including any prior versions)
in any form to the same party or destroy any copies not transferred.

RESTRICTIONS

You may not use, disclose, distribute, copy, modify, rent, lease, loan, resell, network or transfer the
Software, or any copy, modification or merged portion thereof, in whole or in part, to any third party
except as expressly specified in this Agreement. You agree to provide reasonable security precautions to
prevent unauthorized access to or use of the Software as proscribed herein. You agree not to decompile,
reverse engineer, disassemble or otherwise reduce the Software to a human perceivable form and you
agree not to permit any person or entity to do so. You shall not remove, alter, cover, or obscure any
confidentiality, trade secret, proprietary, or copyright notices, trademarks, proprietary, patent, or other
identifying marks or designs from any component of the Software, and you shall reproduce and include
in all copies of the Software the copyright notice(s) and proprietary legend(s) of Filmetrics and its
licensors as they appear in the Software.

SOURCE CODE

If source code to the Software was supplied to you, then you may modify and use that source code in
place of the executable version of the Software, but no further rights to distribution or use are granted.
You acknowledge that you have no obligation to createmodifications of the Software source code
(“Licensed Revisions”) nor to disclose such Licensed Revisions to Licensor. You acknowledge that by
making Licensed Revisions, the underlying Softwaremay not be compatible with any future versions of
the Software that Licensor might offer (in Licensor’s sole discretion), and you agree to assume such risk.
Continuing for the term of this Agreement, you hereby grant to Licensor and its affiliates a limited non-
transferable, non-exclusive, worldwide, fully paid-up, royalty-free license (with the right to sublicense) to
make, use, sell, offer to sell, import, export and otherwise distribute such Licensed Revisions under any
of your patents that, if not authorized, would be directly or indirectly infringed by themanufacture, use,
sale, offer to sell or other distribution of the Licensed Revisions. You may not combine or distribute the
Software or Licensed Revisions with Open Source Software (as defined below) or with software developed
using Open Source Software (e.g., tools) in a manner that subjects the Software and Licensed Revisions
or any portion thereof to any license obligations of such Open Source Software. "Open Source Software"
means any software licensed under terms requiring that other software combined or distributed with
such software: (i) be disclosed or distributed in source code form; (ii) be licensed on terms inconsistent
with the terms of this Agreement.

TERM

This Agreement is effective until terminated. You may terminate it at any time by destroying the Software
together with all copies, modifications and merged portions in any form. This Agreement will
immediately and automatically terminate without notice if you fail to comply with any term or condition
of this Agreement. You agree upon termination to cease using and promptly destroy the Software and
Licensed Revisions together with all copies in any form.



GOVERNMENT LICENSEE

If you are acquiring the Software on behalf of any unit or agency of the United States Government, the
following provisions apply:
The Government acknowledges the licensor’s representation that the Software and its documentation
were developed at private expense and no part of them is in the public domain. The Software is a
"commercial item," as that term is defined at 48 C.F.R. 2.101 (OCT 1995), consisting of "commercial
computer software" and "commercial computer software documentation," as such terms are used in 48
C.F.R. 12.212 (SEPT 1995). All U.S. Government licensees and end users acquire the Software with only
those rights set forth herein.

EXPORT LAW ASSURANCES

You acknowledge and agree that the Software is subject to restrictions and controls imposed by the
United States Export Administration Act (the “Act”) and the regulations thereunder. You agree and certify
that neither the Software nor any direct product thereof is being or will be acquired, shipped, transferred
or re-exported, directly or indirectly, into any country prohibited by the Act and the regulations
thereunder or will be used for any purpose prohibited by the same.

DISCLAIMER OF WARRANTIES. EXCEPT TO THE EXTENT OF ANY LIMITEDWARRANTY PROVIDED BY THE
SELLER, THE SOFTWARE IS FURNISHED "AS-IS", AND TO THEMAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, LICENSORMAKES NOWARRANTY, EXPRESS, IMPLIED OR STATUTORY, INCLUDING ANY
IMPLIEDWARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, TITLE OR NON-
INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE SECRETS OR OTHER INTELLECTUAL
PROPERTY RIGHTS. LICENSOR DOES NOTWARRANT THAT THE SOFTWARE IS FREE FROM BUGS, VIRUSES,
ERRORS OR OTHER PROGRAM LIMITATIONS. YOU AGREE TO USE YOUR INDEPENDENT JUDGMENT IN
DEVELOPING YOUR PRODUCTS. YOU ACKNOWLEDGE AND AGREE THAT LICENSOR IS UNDER NO
OBLIGATION TO INSTALL, MAINTAINOR SUPPORT THE SOFTWARE, OR PROVIDE UPGRADES OR NEW
RELEASES THEREOF, SHOULD LICENSOR PROVIDE ANY ASSISTANCE LICENSORMAKES NOWARRANTIES
WITH RESPECT TO ANY SUCH ASSISTANCE. YOU ASSUME THE ENTIRE RISK ARISING OUT OF THE USE OR
PERFORMANCE OF THE SOFTWARE AND ANY SYSTEMS OR PRODUCTS YOUDESIGNUSING THE
SOFTWARE.
EXCLUSION OF DAMAGES. TO THEMAXIMUM EXTENT PERMITTED BY LAW, IN NO EVENT SHALL
LICENSOR, OR ITS EMPLOYEES, OFFICERS, DIRECTORS, AGENTS, AFFILIATES OR ANY APPLICABLE
LICENSOR (TOGETHER THE “REPRESENTATIVES”), BE LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL,
PUNITIVE OR CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO, DAMAGES FOR ANY LOSS OF
USE, LOSS OF TIME, INCONVENIENCE, COMMERCIAL LOSS OR LOST PROFITS, SAVINGS OR REVENUES,
HOWEVER CAUSED, ONANY THEORY OF LIABILITY, IN CONNECTIONWITH OR ARISING OUT OF THIS
AGREEMENT, THE SOFTWARE, THE LICENSED REVISIONS EVEN IF LICENSOR REPRESENTATIVES HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF A REMEDY SET FORTH HEREIN IS FOUND
TO HAVE FAILED OF ITS ESSENTIAL PURPOSE. IN NO EVENT SHALL LICENSOR’S AGGREGATE LIABILITY
UNDER THIS AGREEMENT EXCEED USD $500.00 OR THE FEES PAID BY YOU FOR THE SOFTWARE UNDER
THIS AGREEMENT. THE LIMITATIONS OF DAMAGES SET FORTH ABOVE ARE FUNDAMENTAL ELEMENTS OF
THE BASIS OF THE BARGAIN BETWEEN LICENSOR AND YOU.

GENERAL

This Agreement will be governed by the laws of the State of California, U.S.A. without regard to its conflict
of law provisions. If a court of competent jurisdiction finds any provision of the Agreement to be



unenforceable, that provision will be enforced to themaximum extent possible to effectuate the intent of
the parties, and the remainder of the Agreement will continue in full force and effect. Failure of Licensor
to enforce any terms of this Agreement shall not be deemed or considered a waiver of future
enforcement of that or any other term in this Agreement and no consent, waiver, or excuse by Licensor,
express or implied, constitutes a subsequent consent, waiver or excuse. You acknowledge that you have
read this Agreement, understand it and agree to be bound by its terms and conditions. You further agree
that it is the complete and exclusive statement of the agreement between us which supersedes any
proposal or prior agreement, oral or written, and any other communications between us in relation to
the subject matter of this Agreement. This Agreement shall bemodified only by a written instrument
signed by a duly authorized representative of Licensor, or from time to time, Licensor may modify or
change the terms and conditions of this Agreement and supersede the terms of any prior version of this
Agreement, in connection with any supplemental, different or new terms that might apply to an update
or upgrade of the Softwaremade available by Licensor, in Licensor’s sole discretion. Your continued use
of the Software after you download and accept the new, additional or changed terms applicable to such
update or upgrade will indicate your agreement to the change to this Agreement. You may not sell,
assign, transfer, delegate, convey, pledge, encumber or otherwise dispose of, by operation of law or
otherwise, the Software, Licensed Revisions or this Agreement, or any rights or obligations hereunder.
Licensor may assign this Agreement, and any or all of its rights and duties under this Agreement, without
prior notice to you or your consent. You hereby warrant and represent that you have obtained all
authorization and other applicable consents required empowering you to enter into this Agreement.
Rights and obligations under this Agreement which by their nature should survive, will remain in effect
after termination or expiration of this Agreement.
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